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Documentation Information 
This section describes the conventions and revision history of this document.  

Conventions 
Icon 

Icon Description  

Tip  Indicates information that can help you make better use of your product. 

Note Indicates references that can further describe the related topics.  

Caution Indicates situations that could cause data loss or equipment damage.  

Warning Indicates situations that could cause minor personal injury.  

Danger Indicates situations that could cause major personal injury or even death.  

 

Notation 

Notation Description  

Bold 
The text in boldface denotes the name of a hardware button or a software interface element. 

For example, press the PTT key.  

-> 
The symbol directs you to access a multi-level menu. For example, to select New from the 

File menu, we will describe it as follows: “File -> New”. 

 

Revision History 
Version Date Description  

R5.0 08-2017 

Firmware version R8.5. 

 Added following new feature. 

 Multisite Handover 

 Dual-slot Data Transmission 

 BT Indoor Positioning 

 Smart Battery Report 

 Follow Free Channel 

 Access Manager 
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Version Date Description  

 Continuous Wave identification (CWID) 

 Application Interface Specification (AIS) 

 Added following features for Dispatching： 

 Data Channel Weak 

 In Call Location Revert 

 QGPS&NormalData option is added in Channel Type of the Data Channel 

R4.0 03-2017 

Firmware version R8.1. 

 Added the XPT Max Sites Num to 16. 

 The voice repeater can forward the GPS and RRS data. 

 Modified the descriptions on Dispatching and Software Requirements. 

 Added the descriptions on FAQ. 

R3.0 12-2016 

Firmware version: R8.0. 

 Added descriptions on Priority Interrupt and Repeater Backup. 

 Modified descriptions on XPT Multi-Site and SIP Phone. 

R2.0 12-2015 

Firmware version: R7.6. 

Added application and configuration descriptions on features such as IP 

Multi-site Connect, Roam, Telemetry, Encrypt, SIP Phone, etc.  

R1.1 03-2015 Updated the version number to be consistent with Chinese version.  

R1.0 03-2015 Initial release  
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1. Overview 
1.1 System Description 
Extended Pseudo Trunk (XPT) is a new distributed trunking system solution developed on the basis of 

self-developed pseudo trunk technology, which is combined with advantages of digital trunking system. XPT 

system has three main advantages:  

 No dedicated control channels 

 Low cost of platform building 

 Load balancing 

1.2 System Background 
Digital conventional communication system combines the advantages of two-way radio communication and 

digital technology, and also has many strengths and functions of analog system. But in conventional 

communication system, the channel resource efficiency is restricted due to that fact that one channel can only 

support two calls at a time at most. Thus, multiple radios communication is restricted in digital conventional 

communication system. Digital trunking system has larger single-site coverage, stronger noise cancelling 

capability and its channel resource can be allocated automatically. But the platform building of trunking system 

is complex and it is inconvenient to upgrade the conventional system to trunking system. Moreover, trunking 

system requires a large amount of equipments and cost.  

XPT system is an economical and practical digital upgrading solution, which can build an extended pseudo 

trunking system using multiple repeaters to solve the above problems. It is suitable for professional customer 

whose digital key business is based on digital conventional communication system. XPT system has the scale 

and efficiency of trunking technology, clearer voice quality, and extended communication capacity realized by 

sharing the logic channel resource of the repeater. It can support high density voice and data communication of 

more users using only one single base station.  

1.3 Operating Principle 
XPT system builds an XPT site by connecting multiple repeaters operating in digital repeating pseudo trunking 

mode in the same area. The system allows the radios to communicate through any of the idle repeaters in the 

site by sharing the logic channels of these repeaters, so as to optimize the channel efficiency. In such case, a 

dedicated control channel is not required any more.  

In XPT system, a service is always initiated through the home repeater first. When the home repeater is busy, 

the radio will switch to other idle repeaters (free repeaters) to initiate the service. In this way, the waiting time 

for accessing the system is shortened, and the communication capacity can be extended to a maximum level 
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while the service quality is guaranteed. Moreover, there is low probability that all logic channels are busy at the 

same time. Therefore, the probability that a call is rejected in XPT system is much lower than in situation where 

only one convention channel is available for accessing. XPT system can help the radio users to perform the 

communication efficiently.  

 

Figure 1-1 Operating Principle of XPT System 

 Home Repeater 

In the XPT site, each radio must be assigned with a repeater in this site as its home repeater through CPS. 

For example, R1 is assigned as the home repeater of M1, M2 and M3 in the figure above.  

When the home repeater is idle, the radio will always monitor its home repeater to determine whether any 

call is made to the radio in XPT system according to the system broadcast information of the home repeater. 

The radio will initiate a call through the home repeater first when the slot of the home repeater is idle.  

Therefore, it is recommended to assign the radios equally to each home repeater, to avoid repeater 

overloading and impacts on service access efficiency.  

 Free Repeater 

In each XPT site, any registered voice repeater with one or two idle slots can be assigned as a free repeater. 

Only one free repeater can exist at a time in one XPT site.  
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When the home repeater is busy, the radio will switch to the channel where the free repeater is operating to 

monitor, and use the idle slot of the free repeater to initiate a call. If the free repeater is busy at the same 

time, it will assign another on-line and idle repeater as the new free repeater, unless all the voice repeaters in 

the site are busy.  

 Home Group 

In the XPT site, one repeater can be assigned with one or more home groups, which operate under this 

repeater. One group can be set as the home group of one repeater only. Home groups of different repeaters in 

the same site must be unique. For example, G1, G2 and G3 are set as the home groups of repeater R1. They 

cannot be set as the home groups of other repeaters.  

When an idle repeater receives a group call request, the repeater will determine whether the group call 

belongs to the home group of the repeater in the same site. If yes, this repeater will inform other repeaters of 

its updated status (repeating a group call), and broadcast signals to inform the monitoring radio, so as to 

allow the home group members to receive the group call. If not, the repeater will reject the request, and the 

radio will not be able to initiate the group call.  

 Voice Repeater: It is used to repeat voice services, message and signaling services between radios. For the 

repeater R8.1 or above, it also can be used to forward GPS and RRS data, when no data channel is configured 

or the Channel Type of all data channels is set as Quick GPS. 

 Data Repeater: It is used to repeat dedicated data services sent by radios to dispatch station.  

For example, during AVL dispatching, the radio is required to report its GPS positioning information 

periodically, so that the dispatch station can position the radio and monitor its track. Therefore, a large amount 

of RRS data and GPS data transmission is required in dispatching. Data repeater can improve the transmission 

efficiency of GPS data, transmitting more data in the same time. Thus, it is recommended to configure one or 

more data repeaters in XPT system when radio dispatching is required.  

1.4 Typical Network Topology 
In the typical topology of XPT multi-site system, the components include radios, repeaters, Ethernet switches, 

routers, IPPBX, third party applications, XNMS, telephone network, etc. The radio makes a call to other 

communication devices through the repeater. The repeaters connect to each other through the switch. XPT sites 

connect to WAN, third party application and XNMS through the router. XPT system connects to the telephone 

system through IPPBX. See the figure below.  
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Figure 1-2 Typical Topology of XPT multi-site system 

XPT system includes single-site system and multi-site system. 

Single-site System 

An XPT single-site system is consisted of one master repeater and multiple slave repeaters, which are connected 

to each other through a switch. Radios in the system can share the idle channels of these repeaters and 

communicate on such channels.  

 Master Repeater: only one master repeater can be set for each XPT system. Besides repeating the services, the 

master repeater is also used to manage other repeaters in the same XPT site. The management includes the 

following aspects:  

 When a repeater is online or offline, the master repeater will inform other repeaters by sending messages.  

 When an XPT site is activated, the master repeater will inform other repeaters in this site of the home 

group configuration by sending broadcast message.  

 Slave repeater: it is used to repeat the services. When a slave repeater is powered on, it will first connect to 

and register with the master repeater. Then it will obtain the IP addresses and ports of other registered 

repeaters from the master repeater. One or more slave repeaters can be set for each XPT multi-site system.  
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The IP address of the master repeater must be a static address (for example, IPv4 address and UDP port 

number). It is recommended that other repeaters in the same XPT site also use the static address. The static 

address will not change with time. If the static address of the master repeater is changed, other repeaters in the 

same XPT site must update their static addresses accordingly.  

The typical topology of XPT single-site system is shown in the figure below. Master and Slave in the figure 

denote master repeater and slave repeater respectively. 

Slave A Slave B Slave C Slave D Slave E

Master F  

Figure 1-3 Typical Topology of XPT Single-site System 

Multi-Site System 

An XPT multi-site system is built by connecting multiple XPT single-site systems through IP network. It is a 

digital repeating system based on IP network. XPT multi-site system can share the channel resources of XPT 

single-site systems while it can extend the communication coverage of XPT system at the same time.  

XPT multi-site system includes the following types of repeaters:  

 Master Repeater: same as that of XPT single-site system. It is used to connect and manage the slave repeaters.  

 Slave Repeater: same as that of XPT single-site system. It is used to repeat services.  

 Submaster Repeater (Submaster): submaster is a special master repeater in XPT multi-site system. One or 

more submasters can be set for each XPT multi-site system.  

 On one hand, submaster serves as the master repeater to manage the slave repeaters in the same site.  

 On the other hand, submaster serves as the slave repeater to connect to and register with the master 

repeater of another site, so as to realize the interconnection between each XPT site, extending the 

communication coverage of XPT multi-site system.  

When XPT multi-site system is operating in public network, the IP address of the master repeater must be the 

static address of public network (for example, IPv4 address and UDP port number). It is recommended that 

other repeaters in the same XPT site also use the static address. The static address will not change with time. If 
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the static address of the master repeater is changed, other repeaters in the same XPT site must update their static 

addresses accordingly. Each master repeater (Including submaster repeater) must perform static mapping on the 

connected router; otherwise, cross-site communication cannot be realized.  

The typical topology of XPT multi-site system is shown in the figure below. Master, Submaster and Slave in the 

figure denote master repeater, submaster repeater and slave repeater respectively. There are four sites in the 

figure below. Each of the first three sites has one submaster repeater and two slave repeaters while the last site 

has one master repeater (Master D) and two slave repeaters. Submaster A, B and C are connected to Master D to 

realize the intercommunication among the four sites.  

Submaster A

Slave Slave Slave Slave Slave Slave 

Submaster B Submaster C

Master D

Slave 

Slave 

Figure 1-4 Typical Topology of XPT Multi-Sites System 

1.5 Restriction 
 The frequencies in XPT system are required to satisfy certain requirements. If the frequencies are configured 

improperly, the generated intermodualtion components will affect the proper operation of the system. Refer to 

Frequency Configuration Requirements for more details.  

 The network cables used in XPT system must be capable of signal shielding; otherwise, the antenna signals 

will interfere with the network signals when the antenna is near the network cable.  

 The network delay must be less than or equal to 480 ms. It is recommended that the network delay should be 

less than or equal to 30 ms to achieve better communication quality. At the mean time, packet loss rate should 

be less than 1%, and network jitter should be less than 60ms. 
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 NAT is supported by the XPT multi-site system. But only one NAT operation is supported. Multiple NAT 

operations are not supported. Symmetric NAT is not supported by the XPT multi-site system. 

1.6 Version 
 R8.5: Added Mutisite Handover, Dual-slot Data Transmission, BT Indoor Positioning, Smart Battery Report, 

Follow Free Channel, Access Manager, CWID, AIS, Data Channel Weak and In Call Location Revert features. 

 R8.1: Added the XPT Max Sites Num to 16. And the voice repeater can forward the GPS and RRS data. 

 R8.0: Added the Priority Interrupt and Repeater Backup features. 

 R7.6: Added XPT Multi-site, Dedicated Data Channel, SIP Phone, Encrypt, Dynamic Authentication and 

Interference Detection features.  

 R7.0: Released the XPT feature. 

These are the major features. Refer to the corresponding release notes for more details.  
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2. Reference 
 Corresponding CPS Help file. 

 Corresponding Release Notes. 
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3. Application Requirements 
3.1 Device Requirements 

3.1.1 Communication Devices 

Radio 

Radios are used as calling and called devices in XPT system. Currently, XPT system supports PD6 and above 

series portable radios, MD6 and above series mobile radios, X1 series portable radios. There is no extra 

requirement on these radios. This document takes PD78X portable radio as an example.  

Repeater 

Repeater is core device in XPT system, which is mainly used to repeat the Tx and Rx requests of the radio. 

Currently, only RD98XS series repeaters (supported frequencies: VHF, UHF1, UHF2, UHF3 and UHF5) are 

supported.  

Combiner 

In an XPT site, the combiner can combine different signals output by each XPT repeater and send all the signals 

through one antenna. In this way, fewer antennas are required. Also, there is no need to change the antennas 

frequently.  

In the same XPT site, it is recommended to use a combiner with a frequency corresponding to that of the 

repeater. And the combiner, the divider and the duplexer should be used together.  

The combiner is an optional device. Please contact your local dealer or us for more information.  

Divider 

The divider used in XPT system is the receiver divider, which can receive multiple signals through one antenna 

at one time, and divide these signals into different signals to allocate them to different XPT repeaters.  

The divider is an optional device. Please contact your local dealer or us for more information.  

Duplexer 

Duplexer is the pilot frequency duplex radio station or diplexer, which is the main part of the repeater. Duplexer 

is used to isolate the Tx and Rx frequency signals to ensure that the repeater can receive and transmit properly 

at the same time.  

The duplexer is an optional device. Please contact your local dealer or us for more information.  

Antenna 

Antenna is used to transmit repeater signals and receive external signals. To connect the repeater to antenna 

feeder, two antennas are required for connection to Rx and Tx ports of the repeater, with the isolation degree 
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between the antennas greater than 60 dB. If the duplexer is used, the Rx and Tx ports can be connected using 

one antenna.  

The antenna is an optional device. Please contact your local dealer or us for more information.  

3.1.2 Network Devices 
Switch Devices  

Switch devices include Ethernet switch, optical fiber switch, etc. Please consult the supplier for detailed 

information.  

Router Devices 

Router devices include firewall, NAT, router (such as CISCO 1841), etc. Please consult the supplier for detailed 

information.  

Computer or Server 

Computer is mainly used for configuring parameters of the repeater and the radio, such as XPT site information, 

CPS configuration of XPT repeater, and network configuration.  

Server is mainly used to configure and run the third-party applications and Extended Network Management 

System (XNMS).  

3.2 Device Connection 
3.2.1 Diagram of Device Connection 

In the XPT site, the XPT repeaters are connected to each other through one switch. They are connected to 

XNMS and dispatch server through the same switch. In such case, the user can manage and monitor the 

repeaters through XNMS, or dispatch the radios in the XPT site through dispatch server at any time and in any 

place.  
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Figure 3-1 Connection Diagram of XPT System, XNMS and Dispatch Server 

3.2.2 Instructions on Device Connection 

 The radio and repeater transfer data to each other through air interface protocol.  

 Repeater and switch are connected to each other through Ethernet port (See Red Boxes in 3.2.1 Diagram of 

Device Connection). Switch is connected to router, XNMS, dispatch server and WAN through Ethernet port 

and transfers voice or data through network cable.  

 Repeater and combiner are connected to each other through Tx port (See Green Boxes in 3.2.1 Diagram of 

Device Connection). Repeater and divider are connected to each other through Rx port (See Orange Boxes in 

3.2.1 Diagram of Device Connection). Combiner and divider both transfer voice or data through RF cable.  

 Tx port of duplexer is connected to ANT port of combiner (See Green Boxes in 3.2.1 Diagram of Device 

Connection) through RF cable. Rx port of duplexer is connected to Rx port of divider through RF cable. ANT 

port of duplexer (See Blue Boxes in 3.2.1 Diagram of Device Connection) is connected to external antenna 

through RF cable.  

 Refer to corresponding references or consult the device operators for detailed information of different devices.  

3.2.3 Instructions on Network Configuration 

 In the LAN, all the repeaters under the same XPT site must be configured with the different Ethernet IP 

addresses, but IP addresses must be in the same network segment.  

 All the repeaters under the same XPT site must be connected to the same switch. Moreover, it is not 

recommended to connect other out-of-system devices (such as file server) to such switch. If other devices are 

connected to such switch, the operation of the XPT site will be adversely affected.  
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 Different XPT sites must be in different network segment. That means it is not allowed to deploy different 

XPT sites in a same network segment. The XPT sites are connected to each other through routers. 

 The switch connected to the repeaters in XPT site can access the WLAN through the router.  

 Static mapping should be performed on the router of each XPT site to map the corresponding ports (including 

IP Connect Networking UDP Port of the master repeater; IP Connect Networking UDP Port of the submaster 

repeater) of the master repeaters (including submaster repeaters). (Refer to Configuring XPT Network 

Parameter for details) 

 The Service Control Port of all repeaters in the same site must be consistent. 

3.3 Software Requirements  
XPT Site Configuration Tool - XptAps 

XptAps is a configuration tool for XPT site, which can greatly improve the configuration efficiency of XPT site 

information. Users can configure the common XPT site information in XptAps and save it into a *.xml format 

file, and then import the configuration file to each repeater and radio through CPS. In this way, XPT site 

information of all repeaters or radios in the same XPT site can be consistent. If the information is configured 

through CPS separately, it will take more time and errors may occur. It is also hard to identify system failure 

through configuration items, such as repeated repeater index number, repeated radio ID, inconsistent frequency 

of radio and repeater.  

Note 

This tool needs not be installed individually. It will be installed when CPS R7.0 or above is installed.  

Customer Programming Software (CPS) 

The dealer can configure the radio and repeater through CPS.  

CPS version must be R7.6 or above. For detailed software version information, please consult your local dealer. 

For better configuration, refer to the help file of CPS for details.  

XNMS 

XNMS is a management and monitoring software for XPT/Conventional repeaters. The software is developed 

for operators to monitor the operation status of the repeaters on the computer. Operators can monitor the 

parameter information and alarm status of all the registered repeaters in the system using XNMS. Also, 

operators can perform basic control and configuration over the repeaters. In this way, operators can 

conveniently monitor and maintain the XPT/Conventional repeaters. Refer to the corresponding guidance of 

XNMS for more details.  

Other Software 

Third party applications, such as dispatching software.  
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4. System Planning and Parameter Configuration 
This section takes the configuration of an XPT single-site system as an example. Refer to 5.1 XPT Multi-Site 

for detailed configurations of XPT multi-site system.  

4.1 System Planning 
An XPT single-site system consists of at least one master repeater and at most eight voice repeaters and eight 

data repeaters. The system can support up to 16 voice channels and 16 data channels at a time. Each XPT 

system can support digital communication of up to 1200 radios.  

Note 

Above is the result of theoretical analysis. The actual number of radios supported by XPT single-site system 

is subject to other factors, such as physical obstacles, topographic obstacles, interference and reliability.  

XPT system can support more radios than conventional system, providing feature supports for more users as per 

their actual needs. In XPT system, the Radio ID ranges from 1 to 65535 (1-65023 are the radio ID, 

65248-65279 are the ID of the system gateway and telephone gateway. When the repeater works as a dispatch 

station, 65280-65535 are the dispatching ID). 

Caution 

The dispatching ID refers to the radio ID dispatched by the repeater, and needs to be configured via the CPS. 

CPS Path: General Setting -> Network -> Radio Services -> Control Center ID. 

Group ID ranges from 1 to 240; emergency group call ID ranges from 250 t0 254; all call ID is 255.  

For XPT single-site system, the frequency of all repeaters must be different, but their color codes can the same 

or different. XPT system can share channel with other systems, but all the channels in the overlapping system 

must have unique frequency and color code combination.  

If the XPT repeaters are removed for upgrade or repair, you need not to re-program the radios in the site and 

shutdown the system, but need to ensure one master repeater in the single-site system, or one submaster repeater 

in the multi-site system. If the XPT repeaters are added, you need to re-program the newly added repeater and 

all radios in the site, and then restart the system. 

XPT system can still operate properly. Moreover, there is no need to shut down the whole communication 

system when removing or adding a repeater in XPT system.  

4.1.1 Channel Frequencies Planning 

When planning the channel frequencies of XPT system, the following important aspects must be concerned 

about:  
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 System Property: Is a new XPT system needed? Or there is already a digital conventional system? 

 Frequency Requirement: Can the current channel frequencies be used in XPT system? Or do new XPT channel 

frequencies need to be added? 

 Data Transfer Requirement: Does XPT system need to transfer large amounts of data, such as GPS data?   

 Conflict Management: Are there any interference issues that need to be addressed?  

To avoid channel interferences, it is recommended to plan the channel frequencies according to Frequency 

Configuration Requirements. The table below explains the calculation result in Configuration Example. 

Channel No.  Tx tf (MHz) Rx rf (MHz) Frequency spacing with upper channel(MHz) 

Channel 1 353 363 / 

Channel 2 353.2375 363.2625 
Tx Frequency Spacing △tf=0.2375 

Rx Frequency Spacing △rf=0.2625 

Channel 3 353.4875 363.5375 
Tx Frequency Spacing △tf=0.25 

Rx Frequency Spacing △rf=0.275 

Channel 4 353.75 363.825 
Tx Frequency Spacing △tf=0.2625 

Rx Frequency Spacing △rf=0.2875 

Table 4-1 Frequency List 

4.1.2 Load Balancing 

When planning the load balancing of XPT system, the following important aspects must be considered:  

 How many users need to be supported by XPT system currently? 

 Will new users be added to the system in the future? System planners should design the system to 

accommodate future users that may be added. 

 It is possible that more channels may need to be added if a great amount of radios are added.  

 The number of radios supported by an XPT system per slot depends on the number of repeaters work in 

the XPT system. When there is only one repeater in the XPT system, 15 to 20 radios are supported per slot. 

 If attempting to put 300 radios on a 2 voice slots, the system will be busy frequently 

 Adding more data repeaters or shortening the GPS update period could also improve the repeating efficiency 

of data slots in XPT system  

4.1.3 Future Considerations 

When planning the XPT system, the expansibility of the system must be considered:  

 What's the maximum number of users the system can support?  
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 The number of users and groups should drive the amount of voice slots required.  

High traffic situation will require more channels in the system to ensure a good quality of service 

 Will new channels or talk groups be added to the system in the future?  

If new channels or groups are added in the future, all radios will need to be reprogrammed. Modifying 

channel parameters and group parameters through the OTAP tool will be supported in the higher version. 

 Is the dispatching feature required currently or in the future?  

4.1.4 Programming Methodology  

Programmers need to follow the same logic as programming a conventional system:  

 Which / how many voice channels do I need to program?   

 Is data transfer needed for the system? What kind of data (short messages, RRS messages, GPS data or 

customized text messages) needs to be transferred?  

 How many data channels can satisfy the daily data transfer requirement?  

 Which groups needs to be configured in the system? By considering the roam feature, which groups should be 

configured as common groups to operate under every site?  

 What kind of special groups do I need to receive on my radio? 

 Does the system need to assign the channels to multiple zones?  

 Does the system need to access an IP application system? 

 Does the system need to access other systems (such as PSTN/PABX system, Dispatch system)? 

4.2 Example: Simple System Design 
This section introduces a good example case that can help you configure the XPT single-site system.  

The XPT contacts information are as follows:  

Group Alias Group ID User Number Activity Applications 

XPT Group A 100 60 High No 

XPT Group B 110 20 Low No 

XPT Group C 120 25 Low No 

XPT Group D 130 20 Low No 

XPT Group E 140 40 High No 

XPT Group F 150 25 Low No 

XPT Group G 160 50 High No 
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Table 4-2 Contacts Information 

 The XPT system will have 240 radio users and 7 groups.  

 In the following example, we will program two voice repeaters (four voice slots).  

The voice repeater is mainly used to repeat the voice and message services initiated by the radios. Also, it 

can repeat the communication between dispatch station and radios.  

 Assign Group A, B and C as the home groups of Repeater 1; assign Group D, E, F and G as the home groups 

of Repeater 2.  

The voice repeaters information is as follows:  

Repeater 
Alias 

Repeater 
ID Repeater Type  Home Group Power Level Tx/Rx Frequency (MHz) 

Repeater1 100 Voice (Master) A, B, C High 353 / 363 (CH X1) 

Repeater2 101 Voice (Slave) D, E, F, G High 
353.2375 / 363.2625(CH 

X2) 

Table 4-3 Repeaters Information 

4.2.1 XPT Site Configuration 

XPT site parameters mainly include Site Common Parameters and Key Parameters of Individual Repeater. 

Step 1 Run XptAps tool in any of the following ways:  

 Run from Start menu. Go to “Start -> All Programs -> Hytera RCPs -> Customer Programming 

Software -> XptAps”. 

 Run from CPS installation directory. Default directory: C:\Program Files\Hytera\Customer 

Programming Software\XptAps.exe.  
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Figure 4-1 Main Interface of XPT Site Configuration Tool 

Step 2 Click Site and select a site to configure the common parameters.  
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Figure 4-2 Common Parameter Configuration Interface of XPT Site 

Parameter Description  Setting 

Alias Set the alias of the site.  

Range: A string 

consisting of 1-16 

characters  

Freq Range 
Set the frequency range for each repeater in the site. After this setting, 

the frequency of each repeater must be set within this range.  

Select from the 

drop down list.  

Operation Mode 

Set the repeater operation mode to XPT Repeater. There are two 

modes (Conventional Repeater and XPT Repeater) for the repeater, 

but the repeater can only operate in one mode for each time.  

Read-only and 

XPT Repeater only 

Site ID Set the ID for the current XPT site.  Range: 1 - 30 
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Parameter Description  Setting 

Power Level 

Set the Tx power level of the repeater in this site.  

 High: High power can extend the coverage, enabling you to 

communicate with farther radios.  

 Low: Generally, low power is recommend for battery saving when 

the communication coverage is enough. However, if you cannot 

communicate with radios located at a distant place with low 

power, please select high power.  

This parameter is 

subject to actual 

situation.  

Default: Low 

Beacon 

The idle repeater broadcasts the beacon signals periodically, and the radio searches the repeater through the 

beacon signals.  

If the XPT system is built on a LAN, please ensure the Interval of all repeaters and radios are the same, while 

Interval of the radio cannot be no less than that of the repeater. 

Interval Set the time interval for repeater beacon signal transmission.  

This parameter is 

subject to actual 

requirements.  

Range: 960-18000 

ms  

Default: 2160 ms 

Duration 

Set the duration for repeater beacon signal transmission.  

It is recommended to configure proper duration according to the 

repeater numbers in the site. See the table below.  

Number of 

Repeater 

Recommended Beacon Duration 

Adjacent Sites≤4 4＜Adjacent Sites ≤8 

 1～3 ≥240 ms ≥360 ms 

 4～6 ≥360 ms ≥480 ms 

 7～8 ≥480 ms ≥600 ms 
 

This parameter is 

subject to actual 

requirements.  

Range: 240-1800 

ms  

Default: 480 ms 

Phone System 

With the feature enabled, the radio can communicate with the telephone . In this part, users can set the related 

parameters of Phone System.  
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Parameter Description  Setting 

Telephone 

Interconnection 

Enables or disables SIP Phone feature. With SIP Phone feature 

enabled, the radio can communicate with telephone terminals through 

the SIP Phone feature. Otherwise, the radio cannot communicate with 

telephone terminals.  

Select Enable to 

enable this feature.  

Phone Gateway 

ID 
Set the gateway ID which is used to identify the Phone Call.  

This parameter is 

subject to actual 

requirements.  

Range: 

65248-65279  

Default: 65279  

Buffer Dial 

Contact Name 
Set the type of buffer dial contact.  

Read-only. 

Gateway ID by 

default.  

Connect Code 
Set the connect code for the radio to access the phone system. To use 

the Phone feature, the radio must access the phone system first.  

This parameter is 

subject to actual 

requirements.  

Range: 0-9, A, B, 

C, D, *, #, P 

Disconnect 

Code 

Set the disconnect code for the radio to exit the phone system. To end 

a phone call, the radio should exit the phone system by sending the 

disconnect code.  

This parameter is 

subject to actual 

requirements.  

Range: 0-9, A, B, 

C, D, *, #, P 

Table 4-4 Descriptions on Common Parameters of XPT Site 

Step 3 Configure the key parameters of master repeater and slave repeater as per actual needs.  

 Add or delete the repeaters as per actual needs.  

There are four repeaters (CH X1 to CH X4) in a site by default. To add a repeater, right-click a 

repeater and select Add Voice Repeater or Add Data Repeater; to delete a repeater, right-click the 

repeater to be deleted and select Delete Repeater. 
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Figure 4-3 Adding or Deleting Repeaters 

In the planning example, we need one master repeater (CH X1) and one slave repeater (CH X2).  

In a site, there is at least one voice repeater (one master repeater) while at most eight voice repeaters 

and eight data repeaters. But only one master repeater can be set for each site. The first repeater in 

each site is set as the master repeater by default. The rest repeaters are set as slave repeaters.  

 Configure the key parameters of the repeaters.  

The configuration of CH X1 is as shown in the figure below. The configuration of CH X2 is similar 

to that of CH X1, but home group is not required.  

     

Figure 4-4 Master Repeater Parameter Configuration Interface-CH X1 

Parameter Description  Setting 

Basic 
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Parameter Description  Setting 

Repeater Type  

 Master: It is used to manage other repeaters in the 

same site and configure the Home Group for each 

repeater. Only one master repeater must be assigned 

in each site. 

 Slave: Repeaters except for Master Repeater are 

slave repeaters. Slave repeaters are connected to the 

Master Repeater to build the XPT site.  

 SubMaster: The sub master repeater is used to 

connect multiple IP sub site, and has the same 

features as that of master repeater and slave 

repeater. When it works as the master of a sub site, 

it can manage other repeater in this sub site; When 

works as a slave repeater of a higher sub site, it can 

connect to the master repeater of this higher sub 

site, and build up the sub site with other repeaters.  

This parameter is subject to 

actual requirements.  

In planning example, CH X1 is 

the master repeater while CH 

X2 is the slave repeater.  

Channel  

Configures the channel parameters. After importing the configurations into CPS, CPS will write these 

configurations to CH X1 and CH X2.  

Channel Alias Set the alias of the channel.  
Range: A string consisting of 

1-16 characters.  

Color Code 

Set the color code that can indicate a system. Different 

repeaters in the same site can be set with different color 

codes, but repeaters and radios with the same frequency 

in the same site must be set with the same color code; 

otherwise, they cannot communicate with each other.  

Range: 0-15  

Default: 1  

Rx Freq (MHz) Set the Rx frequency of the channel.  In the planning example, Tx 

frequency of Master Repeater 

(CH X1) is 353 MHz, while Rx 

frequency is 363 MHz. 
Tx Freq (MHz) 

Set the Tx frequency of the channel.  

In the same site, the Rx Frequency and Tx Frequency of 

each repeater must be unique.  

Xpt Service 
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Parameter Description  Setting 

Repeater Index 

Set the unique identification number of repeater in the 

site. 

In the single site, the identification number of each 

repeater must be unique. The number of voice repeater 

is a consecutive number starting from 1 while the 

number of data repeater is a consecutive number 

starting from 16.  

Read only. The index number of 

each repeater is assigned by the 

tool automatically.  

Range  

Voice Repeater: 1-8 

Data Repeater: 16-30 

Capacity In Site 

Set the number of repeaters in the current site, including 

voice repeaters and data repeaters. Each XPT site 

supports 1-8 voice repeaters and 0-8 data repeaters. 

Read only. The tool displays the 

number of repeaters in the 

current site according to the 

configuration.  

Range: 1–16  

Home Group 

Set the Home Group for each repeater under the current site. Home Group for different repeaters must be 

unique. This parameter will be available only when Repeater Type is set to Master. 

Repeater Index 
Set the unique identification number of repeater in the 

site. 

Range  

Voice Repeater: 1-8 

Group ID 
Set the home group ID of the repeater. Each site can be 

set with up to 240 home groups.  
Range: 1-240  

Table 4-5 Descriptions on Repeater Parameters 

Step 4 Save the XPT site parameter configurations.  

After configuration, click Export button in Common interface to export and save the configurations 

into a file (.xml format by default). Also, you can import the existing configuration file by clicking 

Import button in Common interface to view and modify the configurations.  
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Figure 4-5 Exporting XPT Site Configuration 

4.2.2 Repeater Configuration 

After configuring the site parameters through XPT tool, you need to configure other parameters of repeaters and 

radios through CPS respectively. All XPT repeaters need to be configured as follows:  

Note 

 After successful file importing, the name of the parameter which has been configured through XptAps will 

turn blue in CPS. See Figure 4-7. 

 It is not recommended to modify the parameters which have been configured through XptAps. If 

modification is required, modify the parameter through XptAps and then import the file into CPS.  

Configuring Repeater Operation Mode 

Set Repeater Operation Mode to XPT Repeater. Currently, XPT system is not compatible with conventional 

repeaters. 

CPS Path: Common -> Setting -> Basic -> Repeater Operation Mode 

Parameters: Repeater Operation Mode 

Description: The repeater in XPT system can only operate in XPT Repeater mode.  

A license is required before using the related features in XPT system. After the license is obtained and if no 

XPT Trunking menu is displayed in CPS, go to “Common -> Feature Control” to enable XPT Trunking first, 

and then go to “Common -> Setting -> Basic -> Repeater Operation Mode” and select XPT Repeater. See the 
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figure below.  

 

Figure 4-6 Enabling XPT Trunking Feature 

 

Figure 4-7 Configuring Repeater Operation Mode 

Importing XPT Site Configuration 

Import the site information and repeater information configured through XptAps into CPS.  

Step 1 Read the repeater to be configured.  

Step 2 Set the site ID and index number of the repeater.  

CPS will import the corresponding repeater configuration according to the site ID and index number 

of the repeater. For example, the site ID is 1 and index number is 3 of a repeater, the CPS will import 
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the corresponding configuration of the repeater with site ID 1 and index number 3. The repeater index 

number is 1 by default. Repeater Index of the voice repeater must be less than or equal to Voice 

Repeater In-Site Num. 

CPS Path: XPT Trunking -> XPT Service -> Setting -> Site Setting -> Repeater Index 

 

Figure 4-8 Configuring Repeater Index 

Step 3 Select “Tools -> Import XPT Setting” on the menu bar of CPS, and then import the XPT configuration 

file following the instructions.  

 

Figure 4-9 Importing XPT Setting 
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Configuring XPT Network Parameter 

 Configure the basic parameters of network.  

CPS Path: XPT Trunking -> General Setting -> Network -> Basic Setting 

Parameters: All parameters in the figure below.  

Description: Refer to the table below.  

 

Figure 4-10 Configuring Network Parameters 

Parameter Description  Setting 

Ethernet IP 

Set the Ethernet IP for the XPT repeater.  

If the XPT system operates in a LAN, the Ethernet IP 

of each repeater in all sites must be fixed and unique. 

Therefore, DHCP should be unchecked.  

Method: Manual input 

Range: 

1.0.0.0-126.255.255.255, 

128.0.0.0-223.255.255.255  
Gateway IP 

Set the gateway IP under TCP/IP protocol for the 

repeater.  

Netmask Set the subnet mask address for the repeater.  

Method: Manual input 

Range: 

0.0.0.0-255.255.255.255 

Table 4-6 Descriptions on Network Parameters 

 Configure the parameters of IP Connect Configuration.  

CPS Path: XPT Trunking -> General Setting -> Network -> IP Connect Configuration 

Parameters: See orange boxes in Figure 4-11 for master repeater configurations. See orange boxes in 

Figure 4-12 for slave repeater configurations.  

Description: Refer to the table below for descriptions on key parameters of IP Connect Configuration. For 

other related parameters, refer to CPS Help.  
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Figure 4-11 Configuring Parameters of IP Connect Configuration-Master Repeater 

 

Figure 4-12 Configuring Parameters of IP Connect Configuration-Slave Repeater 
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Parameter Description Setting 

Repeater Type  

Set the repeater type of IP connection.  

 Master: The repeater serves as the master of the IP site 

and manages other repeaters in the same site. Only one 

master repeater can be set for each XPT system.   

 Slave: The repeater serves as the slave repeater in the IP 

site and connects to the master to build up an IP site. 

Multiple slave repeaters can be set in one site.  

 Submaster: The repeater serves as the master repeater 

and slave repeater at the same time. On one hand, 

submaster serves as the master repeater to manage the 

slave repeaters in the same site. On the other hand, 

submaster serves as the slave repeater to connect to and 

register with the master repeater of another site, so as to 

realize the interconnection between each XPT site, 

extending the communication coverage of XPT 

multi-site system.  

Method: Select from the drop 

down list. 

Master IP Set the IP Address of the master repeater in the XPT site.  

Method: Manual input 

Range: 

1.0.0.0-126.255.255.255, 

128.0.0.0-223.255.255.255  

Note 

This parameter is only 

available for slave repeaters.  

Master UDP 

Port 

Set the User Datagram Protocol (UDP) port number of the 

master repeater in the XPT site.  

UDP is a protocol used for peer-to-peer services within the 

IP network.  

Method: Manual input 

Range: 1024-65535 

Note 
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Parameter Description Setting 

IP Connect 

Networking 

UDP Port 

Set the port number.  

This port is used to establish and maintain the network 

connection between repeaters connected to each other 

through IP network.  

This port number must be different from Remote RDAC 

UDP Port.  

 Master UDP Port is only 

available for slave 

repeaters.  

 

 IP Connect Networking 

UDP Port, Voice & Data 

UDP Port and Service 

Control Port must be 

different.  

 Service Control Port must 

be the same for all 

repeaters in the one site.  

Voice & Data 

UDP Port 

Set the port number.  

This port is used to transmit and receive data or voice 

services through the network.  

Service 

Control Port 

Set the port number.  

This port is used by XPT repeaters to broadcast status 

message and interact with other XPT repeaters.  

Table 4-7 Descriptions on IP Connect Configuration 

XPT system is used with XNMS. Therefore, RDAC Service and RDAC UDP Port are not required.  

Configuring Common Parameters 

CPS Path: XPT Trunking -> Digital Common -> Basic -> Basic Setting 

Parameters: See orange boxes in the figure below.  

Description: Refer to CPS help for more details of Group Call Hang Time, Private Call Hang Time, 

Emergency Call Hang Time and SIT. These parameters must be consistent for all XPT repeaters in the same 

XPT system.  

 

Figure 4-13 Configuring Common Parameters 
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Configuring XPT Service Parameter 

 Configure the parameters of XPT site.  

CPS Path: XPT Trunking -> XPT Service -> Setting 

Parameters: See orange boxes in the figure below.  

Description: Refer to Table 4-4 and Table 4-5 or CPS help for descriptions on key parameters in Site 

Setting pane. It is recommended to configure these parameters through XptAps and not to modify them. 

Refer to Table 5-4 for descriptions on Authentication parameters.  

Note 

Voice Repeater In-Site Num is the number of voice repeaters (including master repeater) in an XPT site. 

One XPT site should have at least one voice repeater. This parameter is available for the master repeater 

only.  

 

Figure 4-14 Configuring Parameters of XPT Site  

 Configure the home group list of the repeater.  

The home group list is required for the master repeater only.  

CPS Path: XPT Trunking -> XPT Service -> Home Group List 

Parameters: See orange boxes in the table below.  

Description: Refer to Home Group in Table 4-5 or CPS help for detailed descriptions. The home group list 

is required for the master repeater only. To modify the home groups, modify them through XptAps and then 

import the file into CPS for programming.  
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Figure 4-15 Configuring Home Group List of Repeater  

Configuring XPT Channel 

XPT channel is the operating frequency of XPT repeater. One repeater can only operate on one channel at a 

time.  

CPS Path: XPT Trunking -> Channel -> XPT Channel 

Parameters: All the figures shown in the figure below.  

Description: Refer to Table 4-5 or CPS help for detailed descriptions.   

 

Figure 4-16 Configuring XPT Channel 

4.2.3 Radio Configuration  

All radios need to be configured as follows:  

Importing Configuration File 

Import the site information configured through XptAps into CPS.  
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Step 1 Read the radio to be configured.  

Step 2 Import the XPT configuration file.  

CPS Path: Tools -> Import XPT Setting -> Select File -> Import 

Configuring XPT Contacts 

Add the required contacts or group into the contact list.  

CPS Path: XPT Trunking -> XPT Service -> Contact -> Contact List  

Parameters: See orange boxed in the figure below. Here we need to add XPT group contacts (call ID from 1 to 

240) and XPT Group A (100), XPT Group B (110), XPT Group C (120), XPT Group D (130), XPT Group E 

(140), XPT Group F (150) and XPT Group G (160). 

Description: Refer to CPS help for detailed descriptions.  

Note 

Group ID in Group ID List is configured through XptAps. If the group call ID added in Contact List is not 

listed in Group ID List, the radio cannot make a group call to such group.  

 

Figure 4-17 XPT Contact Configuration Interface 

Configuring XPT Rx Group 

CPS Path: XPT Trunking -> XPT Service -> Rx Group -> Group list N 

Parameters: All parameters in the figure below.  

Description: Refer to CPS help for detailed descriptions.  
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Figure 4-18 XPT Rx Group Configuration Interface 

Configuring Voice Channel Frequency of XPT System 

Set all available voice channel frequencies supported by the radio in XPT system.  

CPS Path: XPT Trunking -> XPT Service -> System Channel -> Voice Channel Frequency List 

Parameters: All parameters in the figure below. The system channel frequency list is already configured 

through XptAps. CH X1 and CH X2 are corresponding to the frequency information of Repeater 1 and Repeater 

2 respectively.  

Description: Repeaters and radios in the same site and with the same frequency must be set with the same color 

code; otherwise, they cannot communicate with each other. Refer to CPS help for detailed descriptions.  

 

Figure 4-19 XPT Voice Channel Frequency List Configuration Interface 

Configuring XPT Site Voice Channel List 

Add the voice channel of XPT site accordingly.  

CPS Path: XPT Trunking -> XPT Service -> Site Voice List 
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Parameters: All parameters in the figure below.  

Description: Refer to CPS help for detailed descriptions.  

Caution 

The frequency corresponding to the radio sequence number shall be the same as that to the repeater index; 

otherwise the radio cannot communicate with the repeater. The relation between the radio sequence number 

and the repeater index: 

Index of Voice Repeater = Radio Sequence Number in Voice Channel Frequency List 

 

Figure 4-20 XPT Site Voice Channel List Configuration Interface 

Configuring XPT Personality 

XPT Personality defines the common attributes of multiple channels by setting the attributes of the Channel List. 

One channel list is related to one site under XPT system, thus one personality is related to one XPT site. Unlike 

conventional series radios, the radios in XPT system switch the personality (XPT site) instead of channel 

through the Channel Selector knob.  

CPS Path: XPT Trunking -> Channel -> XPT Personality 

Parameters: All parameters in the figure below.  

Description: Refer to the table below for descriptions on key parameters of XPT Personality. For other related 

parameters, refer to CPS Help. Also, you can add multiple personalities in this interface as per actual needs. 
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Figure 4-21 XPT Personality Configuration Interface 

Parameter Description Setting 

Home Channel 

Set a home channel for the channel list, which is 

corresponding to the home repeater. The radio will transmit 

on the home channel first. When the home channel is busy, 

the radio will transmit through other free repeater assigned 

by the XPT system.  

After setting the Voice List, selects a voice channel in the 

voice list as home channel for the radio.  

Method: Select from the 

drop down list. In the figure 

above, the home channel for 

the radio is CH X1 (Repeater 

1).  

Voice List 

Set the voice list used by the radio. The radio will use the 

voice channel in the list to transmit or receive voice 

services. When the home channel is busy, the radio will 

switch to another channel in the list according to the free 

repeater to transmit or receive voice services.  

Method: Select from the 

drop down list. 
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Parameter Description Setting 

Data List 

Set the data list used by the radio.  

When Data List is set to a data list instead of None, the 

radio will use the data channel in the list to transmit RRS 

data and GPS data. 

 When a repeater is used to dispatch services, the Data 
List is set to an effective data list. The Control Center 
ID shall be set between 65280 and 65535. 

 When a radio is used to dispatch services, the Data 
List is set to None. 

Method: Select from the 

drop down list. 

TX Admit 

Restricts the radio transmission when there are ongoing 
activities on the channel.  
 Channel Free: The radio is allowed to transmit when 

the channel is free.  
 Code Color Free: The radio can transmit only when 

the channel is free or the color code is not matched. 

Method: Select from the 

drop down list. 

TX Contact 

Name 

Set a regular contact for the XPT site. The radio initiates a 

call to this contact when the radio user holds down the 

PTT key.  

Method: Select from the 

drop down list. 

Note: 

TX Contact Name is sourced 

from Contact List. Refer to 

Configuring XPT Contacts.  

RX Group List  

Associates a RX Group List with the current XPT site. In 

presence of any activity that matches the group ID in the 

RX Group List, the radio unmutes and allows radio user to 

respond and talk back within the defined Group Call Hang 

Time.  

Method: Select from the 

drop down list. 

Note: 

RX Group List is sourced 

from Rx Group. Refer to 

Configuring XPT Rx Group.  

Emergency 

System 

Associates a predefined XPT emergency system to the 

current XPT site. 

Emergency System is sourced from XPT Emergency. Refer 

to Emergency. 

Method: Select from the 

drop down list. 

GPS Report 

Type 
Set GPS data reporting type of the radio.  

Method: Select from the 

drop down list. 
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Parameter Description Setting 

Beacon Interval 

Set the interval for radios to detect the beacon signals of 

the repeater.  

If the XPT system is built on a LAN, please ensure the 

Beacon Interval of all repeaters and radios are the same, 

while Interval of the radio cannot be no less than that of the 

repeater. 

Method: Manual input 

Note: 

It is not recommended to 

modify this parameter.  

Table 4-8 Descriptions on Key Parameters of XPT Personality 

Adding XPT Personality to Zone 

It is recommended to add all the XPT personalities of the radio to one zone for convenient use and management. 

Each zone can support up to 16 personalities.  

CPS Path: XPT Trunking -> Zone 

Parameters: All parameters in the figure below.  

Description: All XPT personalities of the radio must be added to a certain zone; otherwise, the radio cannot use 

the personalities. Refer to CPS help for detailed descriptions.  

 

Figure 4-22 Adding Personality to Zone 
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5. Other Feature Configurations 
The chapter above introduces the method of configuring basic parameters of XPT system, such as home 

repeater, home group and beacon interval. Besides the basic voice and data services, XPS system also supports 

the following features:  

 XPT Multi-Sites 

 Roam 

 Dedicated Data Channel 

 Dispatching 

 Data Channel Weak 

 BT Indoor Positioning 

 Smart Battery Report 

 Dual-slot Data Transmission 

 Remote Upgrade 

 Single Station Paging 

 Network Management Parameters 

 Interference Detection 

 Emergency Alarm 

 Encrypt 

 Authentication  

 SIP Phone 

 Priority Interrupt 

 Follow Free Channel 

 Access Manager 

 Repeater Backup 

 OTAP  

Refer to the Help document of OTAP Tool for details. 

 Clarity Transmission 

Refer to DMR Radio Clarity Transmission Application Notes for details. 

 Work Order 
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In XPT system, the function, operating principle and configuration of Work Order are almost the same as 

that in conventional system. Refer to Work Order Application Notes of conventional system for details.  

 Telemetry 

Besides the fact that repeater does not support Telemetry feature, the function, operating principle and 

configuration of Telemetry in XPT system are almost the same as that in conventional system. Refer to 

Telemetry Application Notes of conventional system for details. 

 Continuous Wave Identification (CWID) 

 Application Interface Specification (AIS) 

The following sections will introduce the application and configuration of the mentioned features.  

5.1 XPT Multi-Site 
XPT Multi-Sites feature connects multiple XPT single-site systems to each other through WAN to build an XPT 

multi-site system. In this way, XPT system can extend the communication coverage while its existing 

advantages can be ensured.  

5.1.1 Basic Principle 

XPT multi-site feature is designed to achieve a larger coverage by connecting multiple XPT sites in dispersed 

locations over a TCP/IP-based network.  

During the transporting process based on TCP/IP protocol, the XPT protocol is transported by TCP/IP protocol 

and a Hytera-owned protocol locating in the application layer. Accordingly, it is reasonable to conclude that IP 

network only changes the XPT transmission media without affecting the services of XPT radios or repeaters.  

 

Figure 5-1 XPT Multi-Sites Extending Communication Coverage 

5.1.2 Applications  

XPT Multi-Sites can be applied in the following scenarios:  

 To connect two or more XPT single-site systems in different areas 

Example: A client has two XPT sites locating in two remote different areas. The XPT multi-site system can 

connect these two XPT sites and manage them as a whole.  
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 To construct a more effective communication area with wider coverage 

Example: There are multiple XPT sites deployed along the busy metro route to build continuous 

communication coverage. The connection between multiple XPT sites can also solve the communication 

failure problem caused by unfavorable positions or blockings.  

 To broadcast information to the communication coverage of all XPT sites  

Example: In case of emergency, the radios within the communication coverage of the XPT multi-site system 

can be informed by dispatch station or Emergency feature.  

 To use multiple IP-based applications 

Example: The client can use dispatching software, XNMS and so on in XPT multi-site system. Also, 

API-based third-party applications can be used in XPT multi-site system.  

For details on the supported applications and third-party application programming interface (API), please 

contact the equipment providers.  

5.1.3 Typical Network Topology 

For typical network topology of the XPT multi-site system, refer to Multi-Site System.  

 When the XPT Multi-site is used in the private network or local area network, different sites must be 

located in different network segments (that is, different VLAN). The network topology is shown as below: 
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Site 3

VLAN3

Repeater 1

Repeater 2

Repeater 3

Repeater 4
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Repeater 2

Repeater 3

Repeater 4

Repeater 5

Repeater 6

Repeater 7

Repeater 8

Site 1

VLAN1

Repeater 1

Repeater 2

Repeater 3

Repeater 4

Repeater 5

Repeater 6

Repeater 7

Repeater 8

VLAN4

Site 4

Repeater 1

Repeater 2

Repeater 3

Repeater 4

Layer 3 switch

Layer 3 switchLayer 3 switch

Layer 3 switch

Router

 

If no layer 3 switch is available, you can replace it with a router and a switch. 

 When the XPT Multi-site is used in the public network, the network topology is shown as below: 
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5.1.4 Restrictions 

 XPT Multi-Sites feature is a paid feature. You must obtain the authorization before using this feature.  

To enable this feature, you first need to enable XPT Trunking and XPT Multi-Sites in “Common -> 

Feature Control” via CPS. After it, the XPT Max Sites Num will be set to 16 by default. In this case, the 

XPT system has a maximum of sixteen XPT sites (For R8.0 XPT system, it has a maximum of 8 XPT sites; 

while for R7.6, only 4). 

 XPT Multi-Sites feature is subject to the repeater configurations. 
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 XPT Multi-Sites feature is subject to the network type and the configurations of network devices.  

 XPT Multi-Sites feature does not support symmetric routers.  

 All XPT sites must be located in different network segments. 

5.1.5 Parameter Configuration 
System Configurations  

To build an XPT multi-site system, XPT sites, their adjacent site lists and common home groups are required.  

Here we use XptAps for efficient configurations. Do as follows.  

Step 1 Run XptAps. 

Step 2 Import the XPT single-site system configuration file (.xml).  

Step 3 Add one or more XPT sites.  

The configurations of the added site(s) are the same as that of XPT single-site system. Refer to 4.2.1 

XPT Site Configuration for details.  

Note 
A group must be set as the common home group of the corresponding sites to make the cross-site 
group call available. For example, group G1 must be set as the common home group of both Site 1 
and Site 2 before making a cross-site group call to group G1 between Site 1 and Site 2.  

Step 4 Configure the adjacent site list of each site.  

When roaming, the radio will search for the site with the strongest signal strength in the adjacent site 

list first, and then in the roam list. Therefore, please configure the adjacent site list of each site as per 

actual needs to improve the roaming efficiency.  
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Figure 5-2 Configuring Adjacent Site List  

Step 5 Select a site on the left and then click Export to export the configuration file (.xml) of this site.  

Master Repeater Configuration 

Only one master repeater is required for each XPT multi-site system. Besides configurations of the adjacent site 

list by importing the XptAps configuration file into CPS, the configuration of the master repeater in XPT 

multi-site system is the same as that in XPT single-site system. Refer to 4.2.2 Repeater Configuration for 

details. 

Note 

Generally, each site in XPT multi-site system works in different network sections. Therefore, the IP Connect 

Networking UDP Port of the master repeater shall be mapped to the same external and internal port . 

Otherwise, the submaster repeaters operating in other network sections will not be able to connect to the 

master repeater. Moreover, disable the port monitoring or port mirroring function of the router if any, so as 

to avoid interference on the communication of the repeater.  

Slave Repeater Configuration 

The configuration of the slave repeater in XPT multi-site system is the same as that in XPT single-site system. 

Refer to 4.2.2 Repeater Configuration for details. 
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Note 

When configuring the Master IP and Master UDP Port, 

 For the slave repeater in the master site (that is, the site in which the master repeater is located), you 

should ensure that settings of the two parameters are the same as those of the Ethernet IP and the IP 

Connect Networking UDP Port of the master repeater to be connected, respectively. 

 For the slave repeater in the slave site (that is, the site in which the submaster repeater is located), you 

should ensure that settings of the two parameters are the same as those of the Ethernet IP and the IP 

Connect Networking UDP Port of the submaster repeater to be connected, respectively. 

Submaster Repeater Configuration 

The configuration of the submaster repeater is almost the same as that of the master repeater. The following 

configurations are the difference of network parameters.  

Step 1 Set the Repeater Operation Mode of submaster repeater to XPT Repeater and import the XptAps 

configuration file. Then configure the XPT service and channel of the submaster repeater as per actual 

needs. 

The above configurations are the same as those in XPT single-site system. Refer to 4.2.2 Repeater 

Configuration for details.  

Step 2 Set the Repeater Type of submaster repeater to SubMaster.  

CPS Path: XPT Trunking -> General Setting -> Network -> IP Connect Configuration 

 

Figure 5-3 Configuring Repeater Type 

Step 3 Configure the master parameters of submaster.  
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The submaster parameters include master parameters and slave parameters. The parameters in orange 

box in the figure above are the master parameters. The configuration of these master parameters is the 

same as that of master repeater. Refer to Master Repeater Configuration for details.  

Step 4 Configure the slave parameters of submaster.  

Refer to Table 4-7 for detailed parameter descriptions. Please note that, Master IP and Master UDP 

Port must be respectively set to Ethernet IP and IP Connect Networking UDP Port of the master 

repeater connected to this submaster repeater. And the IP Connect Networking UDP Port of the 

submaster repeater shall be mapped to the same external and internal port. 

 

Figure 5-4 Configuring the Slave Parameters of Submaster 

Note 
If VPN is not set up, Master IP and Master UDP Port shall be respectively set to the IP address 
of the master repeater and the mapped IP connect networking port on WAN side. 

5.2 Roam 
The Roam feature enables the radio to transmit or receive services from the XPT system after it moves from one 

XPT site to another. 

This feature is mainly applied in the IP Multi-site Connect System, and includes Active Roam and Passive 

Roam. 

 Active Roam: If the radio disconnects to the current XPT site when initiating a call or transferring data, it 

switches to the available XPT site in Adjacent Site List or Roam List to initiate the call or transfer the data. 

 Passive Roam: If the radio detects RSSI of the current XPT site is lower than the roam RSSI threshold or 

disconnects to the current XPT site, it switches to the XPT site with strongest signal in Adjacent Site List or 

Roam List. 

Radio Configuration 

Besides the radio configuration in XPT single-site system, Roam feature must be enabled and configured 

properly, so that a radio can continue to use the XPT system for communication after it moves from one site to 

another.  
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Step 1 A license is required before using the Roam feature in XPT system. After the license is acquired, go to 

“Common -> Feature Control” to enable the Roam feature through CPS. See the figure below. 

 

Figure 5-5 Enabling Roam Feature 

Step 2 Configure the radio according to the configuration (including master repeater, contacts, voice channel 

and so on) in XPT single-site system. 

Step 3 Select IP Multi-site Connect in XPT Personality and assign a roam list to this personality. Then set 

whether to enable the Auto Start Scan feature as per actual needs.  

If IP Multi-site Connect is unchecked, this personality cannot be assigned with a roam list. When 

roaming, the radio cannot roam to the XPT sites in this roam list. With the Auto Start Scan feature 

enabled, the radio starts roaming upon power-on or switching to this XPT personality from another 

personality.  

CPS Path: XPT Trunking -> Channel -> XPT Personality 

 

Figure 5-6 Assigning a Roam List to XPT Personality 

Step 4 Add other XPT personalities (XPT sites) in XPT multi-site system into the roam list and configure the 

corresponding parameters (alias, RSSI Threshold, etc.) of the list properly.  

After adding other XPT sites into this roam list, when the signal strength of the current XPT site is 

lower than RSSI Threshold or the radio disconnects from the current XPT site, the radio will detect 

the signal strength of other XPT sites in this roam list and roams to an XPT site with satisfying 

conditions. A radio with the firmware version of R8.0 or above can transmit voice or data services 
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while detecting the signal strength of other XPT sites on the roam list. The service is forwarded by the 

original master site (that is, the site in which the radio is in before roaming). 

During roaming, if the signal strength of all sites is lower than the RSSI Threshold value, the radio 

will select one site with strongest signal as the master site. Such temporary master site must satisfy the 

following requirement: signal strength of the temporary site ≥ signal strength of master site + RSSI 

threshold offset. The interval time for the radio to stay at this temporary site is subject to the 

parameter set in the Roam Intercal Time. When this interval time expires, the radio will select 

another site with strongest signal as the master site. 

CPS Path: XPT Trunking -> Roam 

Refer to CPS help file for detailed parameter descriptions. For the XPT system R8.1 or above, the 

maximum sites for the roaming are extended to 16. 

 

Figure 5-7 Configuring the Roam List  

Step 5 (Option) Enable the Multisite Handover feature, and configure the related parameters. 

The Multisite Handover feature can ensure a smooth communication. With this feature enabled, the 

radio automatically switches to a voice channel of the adjacent site with better signals, when it detects 

RSSI of the current site is weak and the multisite handover conditions are met during voice receiving 

or transmitting. To use this feature, the Roam feature must be enabled. 

CPS Path: XPT Trunking -> Roam -> Roam Setting. 

Parameters: The parameters in orange boxes in the figure below. Refer to CPS Help for the 

parameter descriptions. 
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Step 6 (Optional) Configure the Multi-site Handover menu if you want to enable or disable the Multisite 

Handover and Multisite Handover Weak features. 

The Multisite Handover Weak feature can lower the conditions to activate Multi-site Handover 

feature. See Step 6 to set the related parameters. 

CPS Path: XPT Trunking -> General Setting -> Menu -> Roam. 

Parameters: Roam On/Off, Multisite Handover On/Off and Multisite Handover Weak. Refer to CPS 

Help for the parameter descriptions. 

 

Note 
The Roam On/Off and Multisite Handover options can be configured only after the Roam 
option is selected. 

5.3 Data Repeater and Dedicated Data Channel 
To avoid RRS or GPS services occupy the channel frequently and cause voice service initiation failures, users 

can add data repeaters in XPT system and use the data channel (Dedicated Data Channel) to repeat the RRS and 

GPS services. In this case, the voice services will be repeated in the channels of voice repeaters, avoiding voice 

service initiation failures caused by RRS or GPS services occupying the channels.  

5.3.1 XPT Site Configuration 

Step 1 Run XptAps.  
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Step 2 Import the XPT system parameters configured through XptAps in 4.2.1 XPT Site Configuration.  

If the XPT system parameters are not configured through XptAps before hand, refer to 4.2.1 XPT Site 

Configuration to configure the related parameters, including site parameters, adding voice repeaters, 

frequency and color code.  

Step 3 Right-click site and select Add Data Repeater.  

The alias of XPT site is “site”. Add two data repeaters (CH X3 and CH X4). Voice repeaters CH X1 

and CH X2 remain unchanged.  

Step 4 Configure the added data repeaters.  

Configure the parameters of data repeater, such as frequency and color code. Assume that CH X3 and 

CH X4 use Channel 3 and Channel 4 in Table 6-1 as their channels respectively.  

Note 
If Repeater Type is slave and Service Type is data repeater, the range of Repeater Index is 16～
30. 

 

Figure 5-8 Slave Repeater Parameter Configuration Interface-CH X3 

Step 5 Export the configuration result. 
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5.3.2 Configuring Data Repeater 

The configurations of the data repeater are almost the same as that of the voice repeater. Refer to 4.2.2 Repeater 

Configuration for details.  

5.3.3 Configuring Radio  

Besides configuring data channel frequency and data channel list, associating the data channel list with XPT 

personality of the radio, the configuration of the radio is the same as that in XPT system with voice channels 

only. Refer to 4.2.3 Radio Configuration for details. Here we only introduce the differences.  

Configuring Quick GPS System 

Quick GPS feature allows the radio to report more GPS data at a time, so as to improve the efficiency of 

dedicated data channels. When the data channel is associated with quick GPS system and XPT personality is 

associated with this data channel, user can report GPS data quickly in this data channel.  

Note 

Quick GPS parameters are required to be configured for radios with GPS feature only. Before configuring 

Quick GPS parameters, GPS and Quick GPS feature must be enabled through CPS (XPT Trunking -> 

General Setting -> Accessories).  

Skip this section if Quick GPS is not required in dispatching.  

CPS Path: XPT Trunking -> Quick GPS -> QG Sys1 

Parameters: All parameters in the figure below. Refer to CPS help for detailed descriptions. 

 

Figure 5-9 Configuring Quick GPS System 

Configuring Data Channel Frequency of XPT System 

Set all available data frequencies supported by the radio in XPT system.  

CPS Path: XPT Trunking -> XPT Service -> System Channel -> Data Channel -> Data Channel Frequency 

List 
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Parameters: All parameters in the figure below. The system channel frequency list is already configured 

through XptAps. CH X3 and CH X4 are corresponding to the frequency information of Repeater 3 and Repeater 

4 respectively.  

Description: Repeaters and radios in the same site and with the same frequency must be set with the same color 

code; otherwise, they cannot communicate with each other. Refer to CPS help for detailed descriptions.  

Caution 

The frequency corresponding to the radio sequence number shall be the same as that to the repeater index; 

otherwise the radio cannot communicate with the repeater. The relation between the radio sequence number 

and the repeater index: 

Index of Data Repeater = 15 + Radio Sequence Number in Data Channel Frequency List 

 

Figure 5-10 XPT Data Channel Frequency List Configuration Interface 

Configuring XPT Site Data Channel List 

Add the data channel of XPT site accordingly.  

CPS Path: XPT Trunking -> XPT Service -> Site Data List 

Parameters: All parameters in the figure below.  

Description: Refer to CPS help for detailed descriptions. To transmit GPS data through Quick GPS feature, the 

Channel Type of at least one data channel in the data list is set to Quick GPS and this data channel is 

associated with the quick GPS system configured in Configuring Quick GPS System. See the orange boxes in 

the figure below.  

Note 

 For the repeater R8.1 or above, it can forward the data through voice channel or data channel. If no data 

channel is configured, or the Channel Type of all data channels is set as Quick GPS, the radio will 

transmit RRS data and GPS data through the voice channel. 

 For the repeater below R8.1, if the Channel Type of all data channels is set as Quick GPS, the radio 

cannot transmit RRS data and GPS data. 
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Figure 5-11 XPT Site Data Channel List Configuration Interface 

Associating Data Channel List with XPT Personality 

CPS Path: XPT Trunking -> Channel -> XPT Personality 

Parameters: All parameters in the figure below.  

Description: Refer to Table 5-1 for descriptions on key parameters of XPT Personality. For other related 

parameters, refer to CPS Help. Also, you can add multiple personalities in this interface as per actual needs. 

 

Figure 5-12 XPT Personality Configuration Interface 
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Parameter Description  Setting 

Voice List Set the voice list used by the radio.  
Method: Select from the 

drop down list. 

Data List 

Set the data list used by the radio.  

When Data List is set to a data list instead of None, the 

radio will use the data channel in the list to report RRS data 

and GPS data.  

 When a repeater is used to dispatch services, set the 

Data List to an effective data list.  

 When a radio is used to dispatch services, set the Data 

List to None. 

Method: Select from the 

drop down list. 

Location Report 

Type 
Set the location report type of the radio.  

Method: Select from the 

drop down list. 

Battery Report 

Type 
Set the battery report type of the radio. 

Method: Select from the 

drop down list. 

RRS Set whether to report RRS data to the dispatch station. Method: Check 

Table 5-1 Descriptions on Data Channel Parameters 

5.4 Dispatching 
User can perform dispatching using XPT system.  

 Supported Services: Radio Registration Service (RRS), GPS, Call Control (CC), Telemetry, Text Message 

(TMS), Work Order, Over-the-air Programming (OTAP), Radio Control (RC) and Auxiliary Control.  

 Currently, the repeater can serve as the dispatch station in XPT system. 

 For the repeater R8.0 or above, it can dispatch both the radios of its site and other sites. 

 For the repeater below R8.0, it can only dispatch the radios of its site. 

 If the dedicated data repeater is set in XPT system, the radio will use the dedicated data channel of the data 

repeater to send GPS and RRS message. Otherwise, the radio will use the voice channels to send GPS and 

RRS message.  

The network topology is shown below.  
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Figure 5-13 Dispatching Network Topology 

5.4.1 Repeater Configuration 

To dispatch the radios in a certain XPT site, the Application Programming Interface parameters of all repeaters 

in this site must be configured properly. 

CPS Path: XPT Trunking -> General Setting -> Network -> Application Programming Interface. 
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Parameter Description Setting 

Forward To 

PC 

Repeater can repeat the received voice and date to the predefined 

computer server (dispatch station) through IP network. Also, it can 

receive and process the repeating request from the dispatch station, 

so as to realize the communication between the dispatch station and 

the radios. 

Method: Check 

Default: Unchecked 

Third Party 

Server IP 

Set the IP address of dispatching server or gateway. For example, 

192.168.100.1 

Method: Manual input 

Note: The parameter is 

available only when 

Forward To PC is 

checked. 

API 

Interface 

Mode 

Set to Hytera Defined Mode. 

Method: Select from 

the drop down list. 

Note: The parameter is 

available only when 

Forward To PC is 

checked. 

Table 5-2 Descriptions on Application Programming Interface Parameters 

Refer to CPS help for details of other parameters. It is recommended to use the default values if there is no 

parameter conflict.  
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5.4.2 Radio Configuration 
Configuring Network Parameters 

CPS Path: XPT Trunking -> General Setting -> Network 

Parameters: The parameters in orange boxes in the figure below. Refer to Table 5-3 for parameter descriptions.  

 

Figure 5-14 Configuring Network Parameters 

Parameter Description Setting 

Forward To PC 
Unchecked. Otherwise, the parameters below will be 

unavailable. 

Method: Check 

Default: Unchecked 

Control Center 

ID 

Input the corresponding dispatched radio ID. 

Otherwise, the radio may fail to get registered, 

causing dispatching failure.  

Method: Manual input 

Range: 

 65280～65535 if a repeater 

works as a dispatch station 

 1～65023 if a radio works as 

a dispatch station 

Note: The parameter is available 

when Forward To PC is 

deselected. 
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Parameter Description Setting 

RRS Delay 

Registration 

Time 

Set the time between radio power-on and radio 

registration.  

Method: Select from the drop 

down list. 

Range: 10～120s. 

Default: 30s. 

Note: The parameter is available 

when Forward To PC is 

deselected. 

RRS 

Registration 

Retry Counter 

Set the maximum counts for the radio to resend 

registration messages if no acknowledgement is 

received from the control station. If the counter 

expires, the registration program will be terminated 

and the radio is determined as off-line.  

Method: Select from the drop 

down list. 

Range: 5～500. 

Default: 60. 

Note: The parameter is available 

when Forward To PC is 

deselected. 

RRS 

Registration 

Retry Interval 

Set the interval for sending registration messages. 

Method: Select from the drop 

down list. 

Range: 10～300s. 

Default: 30s. 

Note: The parameter is available 

when Forward To PC is 

deselected. 

Table 5-3 Network Parameter for Radio 

Configuring Parameters to Transmit GPS Data 

Step 1 Set the data transmission method of the radio.  

CPS Path: XPT Trunking -> Digital Common -> Basic -> Miscellaneous. 

Parameters: Data Bearer Service. Refer to CPS Help for the parameter descriptions. 

The Data Bearer Service of the radio must be the same as that of the repeater, and the CPS Path is the 

same for the repeater. By default, this parameter is set as Hytera Defined Data. 
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Step 2 Configure Control Center ID, Location Port and Identifier. 

CPS Path: XPT Trunking -> General Setting -> Network -> Radio Services. 

Parameters: Control Center ID, Location Port and Identifier. Refer to CPS Help for the parameter 

descriptions. 

 

Note 
The range of the Control Center ID is as follows. 

 65280～65535 if a repeater works as a dispatch station 

 1～65023 if a radio works as a dispatch station 

Step 3 Enable the GPS feature, and configure the related parameters. 

CPS Path: XPT Trunking -> General Setting -> Accessories -> GPS. 

 

Step 4 Enable the Quick GPS feature, if GPS data is to be transmitted via this feature. 

CPS Path: XPT Trunking -> General Setting -> Accessories -> GPS -> Quick GPS. 
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Note 
This feature is available only when the GPS feature is enabled. 

Step 5 Configure the Voice Channel and (or) Data Channel. 

CPS Path: XPT Trunking -> XPT Service -> System Channel -> Voice Channel/Data Channel. 

Parameters: Refer to Configuring Voice Channel Frequency of XPT System and Configuring Data 

Channel Frequency of XPT System for details. 

 When a radio is used to dispatch services, it can forward the data only through Voice Channel. 

 When a repeater is used to dispatch services, it can forward the data through Voice Channel and Data 

Channel (But for the repeater below R8.1, it can forward the data only through Data Channel). 

 

Step 6 Configure the Site Voice List. 

CPS Path: XPT Trunking -> XPT Service -> Site Voice List. 

Parameters: Refer to Configuring XPT Site Voice Channel List for details. 

 

Step 7 Configure the Site Data List. 

CPS Path: XPT Trunking -> XPT Service -> Site Data List. 
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Parameters: Refer to Configuring XPT Site Data Channel List for details. 

To transmit GPS data through Quick GPS feature, the Channel Type of at least one Data Channel in 

the data list must be set to Quick GPS or QGPS&NormalData, and this data channel has been 

associated with the Quick GPS system configured in Configuring Quick GPS System. 

 

Step 8 Configure the Voice List and (or) Data List. 

CPS Path: XPT Trunking -> Channel -> XPT Personality -> Per XN -> Voice List / Data List. 

Parameters: Refer to Table 5-1 Descriptions on Data Channel Parameters for details. 

 When a repeater is used to dispatch services, the Voice List and (or) Data List are configurable. (But 

for the repeater below R8.1, it only can forward the data through data channel. In this case, the Data 

List cannot be set as None). 

 When a radio is used to dispatch services, it can only transmit the data through voice channel. In this 

case, the Data List must be set as None. 

 

Step 9 Set the GPS Report Type as Normal or Quick GPS. 

CPS Path: XPT Trunking -> Channel -> XPT Personality -> Miscellaneous. 

Parameters: GPS Report Type. Refer to CPS Help for the parameter descriptions. 

Caution 
This parameter is not available if RX Only is selected for current channel. 
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Step 10 Enable the In Call Location Revert feature. 

CPS Path: XPT Trunking -> Digital Common -> Basic -> Miscellaneous. 

Parameters: In Call Location Revert. Refer to CPS Help for the parameter descriptions. 

If disabled, the radio cannot report location data to the dispatch station during voice receiving. Then 

the dispatch station cannot obtain the radio location in real time. In this case, it’s recommended to 

enable the In Call Location Revert feature. 

 

Step 11 (Optional) Enable the Data Channel Weak feature. 

CPS Path: XPT Trunking -> XPT Service -> Setting -> Miscellaneous. 

Parameters: Data Channel Weak. Refer to CPS Help for the parameter descriptions. 

With this feature enabled, the radio automatically switches to the voice repeater to transmit the data 

including GPS, RRS, when it transmits location data in normal way but the data repeater operates 

abnormally, such as unexpected power off, disconnection to the dispatch station. 
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Note 
To enable this feature, the Location Report Type must be set as Normal. 

Configuring Parameters to Transmit RRS Data 

Step 1 Configure respectively the parameters as per Step 1~2 and Step 5~8 in Configuring Parameters to 

Transmit GPS Data, including Data Bearer Service, Control Center ID, Voice Channel, Data Channel, 

Site Voice List, Site Data List, Voice List and Data List. 

Step 2 Enable the RRS feature. 

CPS Path: XPT Trunking -> Channel -> XPT Personality -> Miscellaneous. 

Parameters: RRS. Refer to CPS Help for the parameter descriptions. 

Caution 
The RRS is not available if RX Only is selected. 

 

Step 3 (Optional) Enable the Data Channel Weak feature. 

CPS Path: XPT Trunking -> XPT Service -> Setting -> Miscellaneous. 

Parameters: Data Channel Weak. See Step 10 in section 5.4.2 Radio Configuration. 

With this feature enabled, the radio automatically switches to the voice repeater to transmit the data 

including GPS, RRS, when it transmits location data in normal way but the data repeater operates 

abnormally, such as unexpected power off, disconnection to the dispatch station. 
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Note 
To enable this feature, the Location Report Type must be set as Normal. 

5.5 Dual-slot Data Transmission 
5.5.1 Overview 

The external devices can transfer data from one to another through the Data Transfer or Clarity Transmission 

feature of the radios. When the Dual-slot Data Transmission feature is enabled, the radios transmit or receive 

the data over dual slots to increase the transmission speed and save channel resources. 

5.5.2 Restrictions 
 The feature is used for the data transfer among the radios. 

 The feature is not available if RX Only is selected for current XPT channel. 

 The feature is not available for Dedicated Channel for Priority Interrupt and dedicated data channel. 

 When transferring data over dual slots, the radio can initiate an emergency call only. 

5.5.3 Parameter Configuration 
Portable Radio 

The portable radios support to transfer data through the Data Transfer feature. Please configure the related 

parameters before enabling the Dual-slot Data Transmission feature. 

Step 1 Configure UART (Universal Asynchronous Receiver/Transmitter) related parameters. 

CPS Path: Common -> Accessories -> Basic Setting. 

Parameters: The parameters in orange boxes in the figure below. Refer to CPS Help for the 

parameter descriptions. 

 

Step 2 Enable the Forward To PC feature. 

CPS Path: XPT Trunking -> General Setting -> Network -> Forward To PC. 

Parameters: Forward To PC. Refer to CPS Help for the parameter descriptions. 
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Step 3 Configure the target radio. 

CPS Path: XPT Trunking -> Channel -> XPT Personality -> Per XN -> RX/TX Manage. 

Parameters: TX Contacts Name. Refer to CPS Help for the parameter descriptions. 

 If the data is transmitted to one radio only, set this parameter as call ID of the target radio. 

 If the data is transmitted to multiple radios, set this parameter to call ID of the target group. 

 

Step 4 (Optional) Configure the RX Group List. 

If the data is transmitted to multiple radios, set this parameter as the group list where the target group 

ID is on. 

CPS Path: XPT Trunking -> Channel -> XPT Personality -> Per XN -> RX/TX Manage. 

Parameters: RX Group List. Refer to CPS Help for the parameter descriptions. 
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Step 5 Select Data Transmit Protocol to enable the Dual-slot Data Transmission feature. 

CPS Path: XPT Trunking -> Digital Common -> Basic -> Dual-slot Data Transmission. 

Parameters: Data Transmit Protocol. Refer to CPS Help for the parameter descriptions. 

 

Step 6 (Optional) Disable the Battery Save feature of the receiving and transmitting radios. 

It is recommended to disable this feature to increase the transmission speed. 

CPS Path: XPT Trunking -> General Setting -> Setting -> Battery Save. 

Parameters: Battery Save. Refer to CPS Help for the parameter descriptions. 

 

Step 7 (Optional) Configure the Dual-slot Data option if you want to enable or disable the Dual-slot Data 

Transmission feature via radio menu. 

CPS Path: XPT Trunking -> General Setting -> Menu -> Common Menu -> Radio Settings. 

Parameters: Dual-slot Data. Refer to CPS Help for the parameter description 
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Mobile Radio 

The mobile radios support the Data Transfer and Clarity Transmission features. 

 For Data Transfer, see Portable Radio in section 5.5.3 for the configuration. 

 For Clarity Transmission, please operate as below. 

Step 1 Enable the Clarity Transmission feature, and configure related parameters. 

For details, refer to DMR Mobile Radio_Clarity Transmission_Application Notes. 

Step 2 Select Clarity Transmission to enable the Dual-slot Data Transmission feature. 

CPS Path: XPT Trunking -> Digital Common -> Basic -> Dual-slot Data Transmission. 

Parameters: Clarity Transmission. Refer to CPS Help for the parameter description 

 

Note 
This parameter is available only when Accessory Port Communication is set to UART Clarity 
Transmission. 

Step 3 (Optional) Configure the Dual-slot Data option if you want to enable or disable the Dual-slot Data 

Transmission feature via radio menu. 

CPS Path: XPT Trunking -> General Setting -> Menu -> Common Menu -> Radio Settings. 

Parameters: Dual-slot Data. Refer to CPS Help for the parameter description 
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5.6 BT Indoor Positioning 
When the radio cannot be accurately positioned via GPS indoor, the BT Location feature can be enabled to 

transmit the location data to the control center. Then the dispatcher can view the real-time location of the radio 

and make effective on-site dispatch. To enable this feature, the BT beacons need to be deployed indoor. 

This feature is only available for PD98X. If the repeater is used for dispatching, it must be configured the same 

Beacon Info List as that of the radio. For details, refer to DMR Conventional Radio_BT_User Manual. 

5.7 Smart Battery Report 
5.7.1 Overview 

The Smart Battery Report feature helps users to know battery conditions of the radio. With this feature enabled, 

the radio sends battery data to the control center, such as battery model, lifespan, discharging and recharging 

cycles and battery version. The information is used to evaluate whether the battery needs to be replaced. 

5.7.2 Restriction 

This feature is only available for PD98X with smart battery. 

5.7.3 Parameter Configuration 

Step 1 Configure Control Center ID and Self-Defined Message Port. 

CPS Path: XPT Trunking -> General Setting -> Network -> Radio Services 

Parameters: Control Center ID, Self-Defined Message Port and Identifier. Refer to CPS Help for the 

parameter descriptions. 
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Note 
The range of the Control Center ID: 

 1～65023 if a radio works as a dispatch station. 

 65280～65535 if a repeater works as a dispatch station. 

Step 2 Enable the Smart Battery Report feature, and configure related parameters. 

CPS Path: XPT Trunking -> General Setting -> Accessories -> Smart Battery Report. 

Parameters: Smart Battery Report, Periodical Report, Report Interval Time and Report Start Time. 

Refer to CPS Help for the parameter descriptions. 

 

Step 3 Configure the Voice Channel and (or) Data Channel. 

CPS Path: XPT Trunking -> XPT Service -> System Channel -> Voice Channel/Data Channel. 

Parameters: Refer to Configuring Voice Channel Frequency of XPT System and Configuring Data 

Channel Frequency of XPT System for details. 

 When a radio is used to dispatch services, it can forward the data only through Voice Channel. 

 When a repeater is used to dispatch services, it can forward the data through Voice Channel or Data 

Channel. 
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Step 4 Configure the Site Voice List. 

CPS Path: XPT Trunking -> XPT Service -> Site Voice List. 

Parameters: Refer to Configuring XPT Site Voice Channel List for details. 

 

Step 5 Configure the Site Data List. 

CPS Path: XPT Trunking -> XPT Service -> Site Data List. 

Parameters: Refer to Configuring XPT Site Data Channel List for details. 

The battery data can be only transmitted in normal way. Thus Channel Type must be set as Normal 

Data or QGPS&NormalData. 

 

Step 6 Configure the Voice List and (or) Data List. 

CPS Path: XPT Trunking -> Channel -> XPT Personality -> Per XN -> Voice List / Data List. 

Parameters: Refer to Table 5-1 Descriptions on Data Channel Parameters for details. 

 When a repeater is used to dispatch services, the Voice List and Data List are configurable. 

 When a radio is used to dispatch services, it can only transmit the data through voice channel. In this 

case, the Data List must be set as None. 
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Step 7 Set the Battery Report Type as Normal. 

If set as None, the radio cannot transmit the battery data under current XPT site. 

CPS Path: XPT Trunking -> Channel -> XPT Personality -> Per XN -> Miscellaneous. 

Parameters: Battery Report Type. Refer to CPS Help for the parameter descriptions. 

 

Caution 
The Battery Report Type is not available if RX Only is selected. 

5.8 Emergency 
Configuring XPT Emergency 

Emergency Alarm allows user to ask for help from the companion or the control center in case of emergency. 

When the XPT personality is associated with an XPT Emergency system, user can activate Emergency feature 

by pressing the programmed Emergency key.  

CPS Path: XPT Trunking -> Emergency -> XPT Emergency 

Parameters: All parameters in the figure below. Refer to CPS help for detailed descriptions.  

Note 

The differences between XPT Emergency and Conventional Emergency are as follows:  

 There is no emergency revert channel for XPT Emergency.  

 XPT Emergency Contact is required. This contact must be an XPT Emergency Group Call Contact (XPT 

Trunking -> XPT Service -> Contact -> Contact List) with an ID ranging from 250 to 254. Refer to 

Configuring XPT Contacts for detailed descriptions.  
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Figure 5-15 XPT Emergency Configuration Interface 

5.9 Remote Upgrade 
Remote Upgrade feature must be enabled for the repeater and the related parameters must be configured 

properly to allow the repeater to use the Remote Upgrade feature.  

CPS Path: XPT Trunking -> General Setting -> Network -> Remote Upgrade Service 

Parameters: All parameters in the figure below.  

Description: Refer to CPS help for detailed descriptions.  

 

Figure 5-16 Configuring Remote Upgrade Parameters 

5.10 Single Station Paging 
5.10.1 Overview 

With the feature enabled, when the radio transmits voice or data service, the XPT repeater under single station 

mode first pages the target radio. If it succeeds, the XPT repeater will forward the service to the target radio. 
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But if fails, the XPT repeater will not forward the service to the target radio.  

5.10.2 Restriction 

 The feature is available only for RD98XS.  

 Disable this feature when using the radio with R7.0 firmware. Otherwise, the radio will be unable to transmit 

or receive voice or data service.  

5.10.3 Parameter Configuration 

CPS Path: XPT Trunking -> XPT Service -> Setting -> Site Setting -> Singe Station Paging. 

Parameter: Singe Station Paging. 

 

Parameter Description Setting 

Single 

Station 

Paging 

Enable or disable the Single Station Paging feature of the XPT repeater 

under single station mode. 

 Checked: Enable the Single Station Paging feature.  

In this case, the repeater forwards the voice or data service to the 

target radio only after it successfully pages the target radio. 

 Unchecked: Disable the Single Station Paging feature. 

In this case, the repeater directly forwards the voice or data service to 

the target radio. 

Method: Check. 

Default: Checked. 

Note: The feature is 

available only for 

RD98XS.  

 

5.11 Network Management Software Connection 
To connect to or manage the repeater through third party network management software or XNMS, user must 

configure the corresponding connection parameters of the repeater.  

CPS Path: XPT Trunking -> General Setting -> Network -> SNMP 



Other Feature Configurations Application Notes 

 

78 

 

Parameters: All parameters in the figure below.  

Description: Refer to CPS help for detailed descriptions.  

 

Figure 5-17 Configuring Network Management Software Connection Parameter 

5.12 Encrypt 
Encrypt can provide end-to-end encryption for communication (including voice and data) in XPT system, so as 

to protect the security of voice and data services. Encrypt allows the target radio rather than other unauthorized 

radios to receive the voice and data privately.  



Application Notes Other Feature Configurations 

 

79 

 

Normal 
Voice/Data Encrypt

Key/Encrypti
on Algorithm

Encrypted 
Voice/Data

Air Interface

Encrypted 
Voice/DataDecryptNormal 

Voice/Data

Key/Encrypti
on Algorithm

Source Radio

Target Radio

 

Figure 5-18 Diagram for Encryption and Decryption 

XPT system only supports Full Encrypt-Hytera. The encryption properties of each channel in the XPT 

personality are configured at one time according to such XPT personality.  

Besides the above differences, Encrypt feature in XPT system has similar application and configurations as that 

in conventional system. Refer to Encrypt Application Notes of conventional system for details. CPS Path for 

Encrypt feature in XPT system:  

 XPT Trunking -> Digital Common -> Encrypt 

 XPT Trunking -> Channel -> XPT Personality -> Encrypt 

5.13 Authentication  
Authentication between radio and repeater can prevent illegal radios from operating in the system, ensuring the 

security of the system. After the radio and repeater authenticate each other successfully, they can perform the 

corresponding services.  

5.13.1 Repeater Configuration 

CPS Path: XPT Trunking -> XPT Service -> Setting 

Parameters: All parameters in the figure below.  
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Description: Refer to CPS help for detailed descriptions. Make sure that Authentication, Dynamic 

Authentication and Authentication Key of all radios and repeaters in the XPT system are configured 

consistently.  

 

Figure 5-19 Configuring Authentication Parameters 

Parameter Description  Setting 

Authentication  

Enables or disables the Authentication feature for XPT 

system. It is recommended to enable this feature to prevent 

illegal radios from accessing the XPT system.  

If the current XPT system requests for authentication, make 

sure that all radios and repeaters in the XPT system have 

enabled Authentication feature and are configured with the 

same Authentication Key. 

Method: Check 

Note: The feature is available 

only for the voice repeater. 

Dynamic 

Authentication 

Enables or disables the Dynamic Authentication feature for 

XPT system.  
Method: Check 

Authentication 

Key 

Set the authentication key for XPT system. All radios and 

repeaters in the XPT system must be configured with the 

same Authentication Key.  

Method: Manual input 

Range: A string of 32 hex 

characters, each character can 

be 0 to F.  

Table 5-4 Descriptions on XPT Authentication Parameters 

5.13.2 Radio Configuration  

CPS Path: XPT Trunking -> XPT Service -> Setting 

Parameters: All parameters in the figure below. 

Description: Refer to CPS help for detailed descriptions. Make sure that Authentication, Dynamic 

Authentication and Authentication Key of all radios and repeaters in the XPT system are configured 

consistently.  
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Figure 5-20 Configuring Authentication Parameters 

5.14 Interference Detection 
Repeater is the core device of XPT system. If the uplink frequency (Rx frequency) or downlink frequency (Tx 

frequency) of the repeater is interfered, the communication will be adversely affected. Therefore, the 

interference of uplink frequency and downlink frequency must be detected and processed accordingly.  

 When a free repeater finds its uplink frequency is interfered by analog signals of the same frequency, and 

some vacant repeaters exist in current XPT site, it will assign another vacant repeater as the new free repeater 

to avoid the interference. If there is no vacant repeater, it will continue to work as the free repeater. 

 The repeater cannot detect whether downlink frequency of the repeater is interfered by itself. In this case, you 

need to use a third party device or a mobile radio to detect whether downlink frequency of the repeater is 

interfered. When the strength of the carrier signal detected by a third party or a mobile radio is greater than or 

equal to RSSI Threshold for more than 430 ms, and it is confirmed as interference, the repeater will stop 

transmitting. The repeater will restore transmitting when the interference signal disappears. The radio 

disconnected with the repeater due to interference will switch to a free repeater through scanning.  

It is recommended to configure the Interference Detection feature of the repeaters in the same site through 

XptAps and import the configuration to each repeater through CPS for consistency. It is not recommended to 

configure the repeaters separately through CPS. See the following operations:  

Step 1 Configure the Interference Detection feature through XptAps.  

This section only introduces the configuration of Interference Detection feature. Refer to the 

corresponding chapters for configurations of other features.  
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Figure 5-21 Configuring Interference Detection Parameters 

Parameter Description  Setting 

Interference 

Detect 

With Interference Detection feature enabled, t  

If the XPT system is built on a LAN, make sure that the 

Interference Detection features of all repeaters in the XPT 

system are configured consistently.  

Select Enable to 

enable this 

feature. 

RSSI 

Threshold 

Set the RSSI threshold of Interference detection. The 

repeater will stop transmission when the interference 

signal is greater than or equal to this threshold.  

If the XPT system is built on a LAN, make sure that the 

RSSI Threshold of all repeaters in the XPT system is 

configured consistently.  

Range: -120 to 

-16 dBm 

Default: -100 

dBm 

Table 5-5 Descriptions on Interference Detection Parameters 

Step 2 Export the configuration result.  

Step 3 When configuring the repeaters in this XPT site, import the configuration result into CPS first, and then 

configure other parameters.  
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The configuration result of Interference Detection feature can be viewed on CPS (XPT Trunking -> 

Channel -> XPT Channel). 

After performing steps above, the repeater will detect interference in the uplink frequency. If you want to detect 

whether downlink frequency of the repeater is interfered, steps below must be performed too.  

Step 1 Set the Rx frequency of a mobile radio as the Tx frequency of the repeater. Then set the Feature of one 

pin of the mobile radio as Interference Detect, and set the Active Level of this pin to High or Low.  

CPS Path: XPT Trunking -> General Setting -> Accessories -> GPIO Pins. 

Here takes a mobile repeater as an example. If you want to detect interference by the third party 

equipment, please see its accompanying documents for details. 

 

Step 2 Set the Feature of one pin of the repeater as Interference Detect, and the Active Level of this pin must be 

the same as that of the mobile radio. 

CPS Path: XPT Trunking -> General Setting -> Accessories -> GPIO Pins. 



Other Feature Configurations Application Notes 

 

84 

 

 

Step 3 Connect the mobile radio with the repeater by a pin line.  

5.15 SIP Phone 
Session Initiation Protocol (SIP) Phone Call is a feature that realizes the real-time communication between the 

radio and telephone (including PSTN phone, VoIP phone and mobile phone). It complies with SIP protocol and 

uses XPT repeaters as the carriers.  

5.15.1 Basic Principle 

XPT system registers the private contacts and group contacts to IPPBX device and intercommunicates with 

other telephone terminals through IPPBX device, so as to realize the real-time communication between radios 

and telephone terminals.  

 

Figure 5-22 Diagram of SIP Phone Call 

Radio Calling Telephone Terminal 

When the radio makes a call to the telephone terminal, it will input the phone number through Dual Tone 

Multi-Frequency (DTMF) key to generate DTMF voice signaling of the phone number and send the signaling to 
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the repeater. After receiving the voice signaling, the repeater will decode it to obtain the phone number. Then 

the repeater will use the phone number to generate a call request of SIP protocol and send it to the IPPBX 

device. IPPBX will search for the address and location of the phone number and access the telephone network 

through the corresponding interface according to the relevant rules. Finally, the radio call is made to the 

telephone device.  

Telephone Terminal Calling Radio 

When the telephone terminal makes a call to the radio, the telephone network will repeat the call request to the 

IPPBX device. IPPBX device then repeats the call request to the repeater. Finally, the repeater repeats the call 

to the radio.  

5.15.2 Typical Topology 

 

Figure 5-23 Typical Topology of SIP Phone Call 

5.15.3 Restriction 

 This feature is only available for portable and mobile radios with display.  

 In SIP phone network, phone gateway ID, radio ID and repeater ID must be unique, and must differ from the 

ID of other radios or repeaters in the XPT system as well. 

5.15.4 Parameter Configuration 

SIP Phone feature in XPT system has the following differences with that in conventional system:  

 No need to assign the slot which is used to repeat SIP phone only.  
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 Ranges of radio ID and phone gateway ID are different. 

In XPT system, the radio ID ranges from 1 to 65023, phone gateway ID from 65248 to 65279, group ID from 

1 to 240, emergency group call ID from 250 to 254 and all call ID is 255. If the XPT system supports SIP 

Phone feature, the phone gateway IDs of all repeaters in this system must be the same.  

 If a radio needs to use the SIP Phone feature, set the Buffer Dial Contact Name to Phone Gateway ID, and the 

value of the Phone Gateway ID must be between 65248 and 65279. Otherwise, the XPT personality of the 

radio cannot associate with a phone system, which means it cannot use the SIP Phone feature. 

 If an XPT site needs to use the SIP Phone feature, this site must be connected to an IPPBX gateway. Moreover, 

all repeaters in this site must enable the parameter Telephone Interconnection Enable. If multiple sites are 

connected to the same IPPBX, the extension numbers of these sites must be unique.  

 The followings are only applicable to the R8.0 or above XPT system. 

 To use the SIP Phone feature in the XPT single-site system, you must enable the ALG feature in the router. 

For details on the ALG configuration, refer to its online help. 

 To use the SIP Phone feature in the XPT multi-site system, you must disable the ALG feature in the router, 

and establish static port mapping for Radio Voice Service Slot1 Port and Radio Voice Service Slot2 Port in 

the router. Within one XPT site, different repeaters must be mapped to different WAN ports. 

Besides the above differences, SIP Phone feature in XPT system has similar configurations as that in 

conventional system. Refer to SIP Phone Application Notes of conventional system for details. CPS Path for 

SIP Phone feature in XPT system:  

 XPT Repeater:  

 XPT Trunking -> General Setting -> Network -> SIP -> SIP Remote Port 

 XPT Trunking -> Phone -> Phone System 

 XPT Trunking -> Phone -> Phone Call 

 XPT Radio:  

 XPT Trunking -> Phone -> Phone System 

 XPT Trunking -> Phone -> Phone List 

 XPT Trunking -> Channel -> XPT Personality -> Miscellaneous -> Phone System 

5.16 Priority Interrupt 
5.16.1 Overview 

The Priority Interrupt feature is used to interrupt the ongoing call to release channel for new services. This 

feature is also used for channel management to optimize channel efficiency. 
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There are four types of priority interrupt. 

 Button Priority Interrupt: you can press the preprogrammed key to interrupt the ongoing calls on the channel. 

 Talkback Priority Interrupt: you can press the preprogrammed shortcut key to cut into an active call. 

 Emergency Priority Interrupt: in case of an emergency, you can interrupt any normal call to gain channel 

resource for an emergency call. 

 Dispatch Station Priority Interrupt: This feature is used for dispatch station. After receiving the command of 

priority interrupt from the dispatch station, the repeater sends this command to the radio on the timeslot 

adjacent to the one to be interrupted, and notify the radio to end current ongoing service. This feature includes 

two types of services, polite interrupt and impolite interrupt. For polite interrupt, the radio must decode the 

received Priority Interrupt command; otherwise, the radio does not respond to the command.  

The following diagram shows the workflow of the priority interrupt feature. 

 

The workflow includes: 

1. The initiating radio makes a Priority Interrupt request. 
2. The XPT system receives the priority interrupt request and sends the priority interrupt command. 
3. The receiving radio receives the priority interrupt command and releases the channel resource. 
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5.16.2 Restrictions 

 The Priority Interrupt feature is a paid feature for the radio. You must obtain the authorization before using this 

feature properly. The repeater supports this feature by default. 

 Both the radio and repeater must work in XPT mode at the same time. 

 The Priority Interrupt feature is applicable to voice service only rather than data service. 

 A radio with firmware version of R8.0 only supports Button Priority Interrupt, Talkback Priority Interrupt, 

Emergency Priority Interrupt, and Dispatch Station Priority Interrupt. 

5.16.3 Parameter Configuration 

For Initiating Radio 

Step 1 Read the configuration data from on the initiating radio through CPS. 

Step 2 Go to “XPT Trunking -> Channel -> XPT Personality -> Per N” to select the Priority Interrupt 

Encode. 

 

A radio can make an interrupt request only when the Priority Interrupt Encode is selected through 

CPS. 

Step 3 To enable the Talkback Priority Interrupt feature, set In Call TX Admit to Priority Interrupt. 

Step 4 To enable the Emergency Priority Interrupt feature, go to “XPT Trunking -> Emergency -> XPT 

Emergency -> XPT SysN” and select the Emergency Priority Interrupt. 

Since the Priority Interrupt feature is applicable to voice service only, it is recommended that you do 

not set the Emergency Type to None or Siren Only. 
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Step 5 To enable Emergency Priority Interrupt feature, the Emergency System Alias must be the same as that 

set in Step 2. 

Step 6 To enable Button Priority Interrupt feature, the Priority Interrupt feature must be assigned to a 

programmable key. 

Go to “XPT Trunking -> General Setting -> Buttons” to assign the Priority Interrupt feature to a 

programmable key, for example: 

 

Step 7 If this feature is expected to be used frequently, it is recommended that you set the channel of the master 

repeater in the site as the dedicated channel for priority interrupt. 

The dedicated channel for priority interrupt is used to forward the priority interrupt request only, 

ensuring quick response to the received priority interrupt requests. 

To set the Dedicated CH for Priority Interrupt, go to “XPT Trunking -> XPT Service -> Site Voice 

List -> Voice ListN”. 

Configuration result is as follows: 
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Note 
The frequency of the Dedicated CH for Priority Interrupt must be set the same as that of the 
master repeater in the site, and the sequence number must be the same as the index of the master 
repeater. 

For Receiving Radio 

Step 1 Read the configuration data from on the receiving radio through CPS 

Step 2 Go to “XPT Trunking -> Channel -> XPT Personality -> Per N” to select the Priority Interrupt 

Decode. 

A radio can respond to a button priority interrupt request only when the Priority Interrupt Decode is 

selected through CPS.  

 

For Repeater 

Step 1 Read the configuration data from the master repeater through CPS. 

Step 2 If this feature is expected to be used frequently, it is recommended that you go to “XPT Trunking -> 

XPT Service -> Setting” and select Dedicated CH for Priority Interrupt for the master repeater. 

 

With Dedicated CH for Priority Interrupt selected, the radio will send the priority interrupt 

command through slot 2 of the master repeater if the adjacent slot is busy. Slot 2 of the master 

repeater is a dedicated slot for priority interrupt. If the master repeater fails, the priority interrupt 

command will be forwarded through another available repeater in the XPT system. 
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Caution 
This parameter must be configured in the same way for both the repeater and the radio. Otherwise, 
an error may occur. If this parameter is selected, you should set the channel of the master repeater 
in the site where the radio is located as the dedicated channel for priority interrupt. 

With the priority interrupt feature enabled: 

 The radio user can press the pre-programmed priority interrupt key to interrupt an ongoing call on the channel. 

 The radio user can press the PTT key to forcibly get the talk priority. 

 If no channel is available after the emergency alarm is triggered, XPT system will automatically end the 

normal call to release the channel resource for emergency code and emergency call. Thus, the control center 

and corresponding personnel can receive the emergency alarm in time. 

XPT system will end the normal call in the following descending order: private call, group call, and then all 

call. If the normal calls to be ended are of the same type, XPT system will interrupt one of them randomly. 

5.17 Follow Free Channel 
The Follow Free Channel feature can reduce the delay in receiving a call to avoid missing the important voice. 

With this feature enabled, the radio follows the channels which the free repeater is operating on to monitor the 

calls when it is idle. 

CPS Path: XPT Trunking -> XPT Service -> Setting -> Miscellaneous 

Parameters: Follow Free Channel. Refer to CPS Help for the parameter descriptions. 

 

5.18 Access Manager 
The Access Manager feature can enhance the security of XPT system. It prevents the unregistered radios from 

accessing the repeater to transmit the services. Users can configure the ID range of the radio via CPS. The 

repeater only delivers the services of the radio whose ID is within the preset range. 

CPS Path: XPT Trunking -> General Setting -> Access Manager -> Local Access Management 
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Parameters: Local Access Management, Start ID and End ID. Refer to CPS Help for the parameter 

descriptions. 

 

5.19 Repeater Backup 
The Repeater Backup feature is a mechanism that guarantees the smooth operation of the repeater in the event 

of a breakdown. The two repeaters are deployed in the system. When one repeater in normal operation (Work 

Repeater) fails, the other available repeater in backup state (Backup Repeater) will automatically take over the 

repeating function. 

Refer to DMR Repeater Repeater Backup Application Notes R1.0 for details. 

5.20 Continuous Wave Identification 
The Continuous Wave Identification (CWID) code is the ID that the device regularly sends to the control center. 

If the CWID code is applied to manage the devices in the area where the repeater locates, the CWID feature of 

the repeater must be enabled. With this feature enabled, the repeater sends the CWID code at a specified 

frequency. 

CPS Path: XPT Trunking -> General Setting -> CWID. 

Parameters: See orange boxes in the figure below. Refer to CPS Help for the parameter descriptions. 
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5.21 Application Interface Specification 
5.21.1 Overview 

The Application Interface Specification (AIS) feature enables third-party software that is developed based on 

AIS standard to communicate smoothly with XPT repeater so as to control and dispatch the radio services, such 

as voice services, message, radio disable/enable, remote monitor, alert call, emergency and radio check. 

A typical topology for AIS is as below. 

 

5.21.2 Restrictions 

 This feature is only available for the repeater. 

 This feature is available only when the Forward to PC feature and Telephone Interconnection Enable feature 

are disabled. 
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5.21.3 Parameter Configuration 
Master Repeater Configuration 

Enable the AIS feature, select AIS Server Enable, and then configure the related parameters as needed. 

CPS Path: XPT Trunking -> AIS -> AIS -> AIS Setting. 

Parameters: See orange boxes in the figure below. Refer to CPS Help for the parameter descriptions. 

 

Salve Repeater Configuration 

Enable the AIS feature, set AIS Gateway IP same as that of the master repeater, and then configure the related 

parameters as needed. 

If it’s the XPT multi-site system, the AIS Voice Service Slot 1 Port and AIS Voice Service Slot 2 Port of each 

repeater in one site must be unique. 

CPS Path: XPT Trunking -> AIS -> AIS -> AIS Setting. 

Parameters: See orange boxes in the figure below. Refer to CPS Help for the parameter descriptions. 

 

SubMaster Repeater Configuration 

If it’s the XPT multi-site system, the AIS feature must be also enabled for the submaster repeater, and AIS 

Gateway IP be the same as that of master repeater. 

The AIS Voice Service Slot 1 Port and AIS Voice Service Slot 2 Port of each repeater in one site must be unique. 
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CPS Path: XPT Trunking -> AIS -> AIS -> AIS Setting. 

Parameters: See orange boxes in the figure below. Refer to CPS Help for the parameter descriptions. 

 

Router Configuration 

 In XPT single-site system, ALG feature of the router must be enabled. For the configuration, refer to its 

manual. 

 In XPT multi-site system, ALG feature of the router must be disabled and static ports be mapped for AIS Voice 

Service Slot1 Port and AIS Voice Service Slot2 Port in the router. Different repeaters must be mapped to 

different WAN ports in one XPT site. 
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6. FAQ 
6.1 XPT System 
Q: How to plan the XPT system to achieve best communication quality before building the system?  

A: The communication quality of the XPT system is subject to many factors, such as communication distance, 

blocking or interference in communication. This section only introduces the way to choose a suitable channel to 

minimize the interference and achieve better communication quality.  

Frequency Configuration Requirements 

Assume that there are four repeaters. They use Channel 1, 2, 3 and 4 respectively. Rx frequencies of Channel 1, 

2, 3 and 4 are rf1, rf2, rf3 and rf4 respectively and frequency spacings between the Rx frequencies are △rf1, 

△rf2 and △rf3. Tx frequencies of Channel 1, 2, 3 and 4 are tf1, tf2, tf3 and tf4 respectively and frequency 

spacings between the Tx frequencies are △tf1, △tf2 and △tf3. The channel bandwidth of the repeater is BW.  

To avoid intermodulation interference, all frequencies should satisfy the following conditions at the same time:  

 The difference between any two of △rf1, △rf2, △rf3, △tf1, △tf2, △tf3 ≥ BW 

 (The smallest among △rf1, △rf2, △rf3) - (The difference between any two of △rf1, △rf2, △rf3) ≥ BW 

 (The smallest among △tf1, △tf2, △tf3) - (The difference between any two of △tf1, △tf2, △tf3) ≥ BW 

 The Tx frequency and Rx frequency of the same channel must be unique  

 It is recommended that Tx and Rx frequency spacing between different channels should be unique.   

Configuration Example 

Assume that XPT system has four channels with BW=12.5 kHz. When selecting the frequencies, increase the 

value of frequency spacing between each channel gradually according to the bandwidth. In this way, 

intermodulation interference can be avoided and the frequencies comply with the operation principle of 

duplexer and combiner. See the figure below.  
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Tx Frequency

tf1 tf2 tf3

△tf1=△f+
BW

△tf2=△f+
2BW

Rx Frequency

△rf1=△f+
4BW

△rf2=△f+
5BW

rf1 rf2 rf3

△tf2=△f+
3BW

△rf2=△f+
6BW

tf4 rf4

 

Figure 6-1 Reference for Frequency Configuration 

To configure the frequencies in XPT system, do as follows:  

1. Set the frequency of Channel 1 (UHF3) to tf=353 MHz (Tx) and rf=363 MHz (Rx).  

2. Set the Tx frequency spacing between Channel 2 and 3 to △tf2=250 kHz, which is the frequently-used 

frequency spacing of UHF3 combiner.  

3. Calculate the fixed frequency spacing △f=225 kHz according to equation △tf2=△f+2BW.  

4. Calculate other frequencies according to △tf, △rf, BW  and the frequency of Channel 1. The equations are as 

follows:  

Assume that XPT system has N channels. The frequency spacing between Channel (M-1) and Channel M is 

set to △tfm, which is the frequently-used frequency spacing of a combiner in certain frequency band.  

Thus, fix frequency spacing △f = combiner frequency spacing △tfm - (M-1) * BW, and  

 Tx frequency = Tx frequency of Channel 1 (i.e. Reference Tx frequency) + (Channel No. - 1) * 

combiner frequency spacing △tfm + (Channel No. - 1) * (Channel No./2 - M + 1) * BW 

 Rx frequency = Rx frequency of Channel 1 (i.e. Reference Rx frequency) + (Channel No. - 1) * 

[combiner frequency spacing △tfm + (Channel No. + 6 - 2M)/2 * BW] 

According to the equations, the calculation results of Channel 2, 3 and 4 are as follows:  

Channel No.  Tx tf (MHz) Rx rf (MHz) Frequency spacing with upper channel 

Channel 1 353 363 / 

Channel 2 353.2375 363.2625 
Tx Frequency Spacing △tf=0.2375 

Rx Frequency Spacing △rf=0.2625 
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Channel No.  Tx tf (MHz) Rx rf (MHz) Frequency spacing with upper channel 

Channel 3 353.4875 363.5375 
Tx Frequency Spacing △tf=0.25 

Rx Frequency Spacing △rf=0.275 

Channel 4 353.75 363.825 
Tx Frequency Spacing △tf=0.2625 

Rx Frequency Spacing △rf=0.2875 

Table 6-1 Frequency List 

 

Q: Why does the slave repeater in XPT mode display the network icon ?  

A: When this icon appears, it indicates abnormal network connection of the repeater. The repeater cannot 

connect to the control center (Master Repeater). This issue may be caused by the following situations:  

 Master IP and Master UDP Port are configured improperly in slave repeater.  

 “Network Authentication Code” of the slave repeater is inconsistent with that of the master repeater.  

 Other repeater in XPT system has configured with a same site ID and index number as the slave repeater.  

 When this slave repeater is a voice repeater, its index is greater than the value of the Voice Repeater In-Site 

Num parameter configured in the master repeater. 

 

Q: Why does the called radio always join a call with delay after the calling radio initiates a call?  

A: This issue may be caused by the following situations:  

 Tx or Rx antenna of the repeater is attached improperly.  

 Master UDP Port of slave repeater is different from IP Connect Networking UDP Port, causing the slave 

repeater fail to receive network status updating message from other repeaters.  

 Beacon Interval of the radio is different with that of the repeater.  

 Network connection of the repeater is abnormal. 

 The member(s) in the RX Group List of the called radio is (are) not included in the Home Group List of 

the master repeater. Please add the members in the RX Group List of the radio to the Home Group List of 

the master repeater to ensure all these calls can be received normally. 

 

Q: Why does the radio display “Authentication Fail!” when it initiates a call?  

A: Radio or repeater has not enabled the Authentication feature, or radio and repeater have configured with 

different authentication keys.  
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Q: Why does the radio display “No Available Channel!” when it initiates a call?  

A: This issue may be caused by the following situations:  

 There is no free repeater in the current system, or there is no available channel after searching for all the 

channels (all repeaters are busy in the system).  

 Try to activate the repeaters by handshaking but there is no available channel on all repeaters.  

 

Q: Why does the radio display “No Called Party!” when it fails to initiate a group call?  

A: This issue may be caused by the following situations:  

 The target group ID is not configured in the Home Group List of master repeater in XPT system 

 The channel parameters of the receiving radio are inconsistent with that of the repeater.  

 

Q: Why does the radio display “No Called Party!” when it fails to initiate a private call?  

A: This issue may be caused by the following situations:  

 When launching a cross-site private call, the called radio is power-off.  

 The called radio is transmitting GPS data or RRS data through a data channel.  

 The called radio is receiving a group call.  

 

Q: Why is the radio interrupted and receive an all call automatically during a private call or group call? 

A: It is a normal situation. XPT system has enabled the Priority Call feature, thus the radio will receive a call 

with higher priority first. Currently, the call priority in descending order is XPT Emergency Call > XPT All 

Call > XPT Private Call or XPT Group Call (XPT Private Call and XPT Group Call have the same priority).  

 

Q: Why cannot other repeaters receive a call initiated by the radio even if the radio is registered successfully 

and the network connection number of the current repeater which is monitored by the radio is normal? 

A: “Service Control Port” of the current repeater is different from those of other repeaters in the XPT system, 

disabling the repeaters from transferring information in network through broadcasting pack.  

 

Q: Why does the radio display “Out of Range!” upon power-on?  
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A: This issue may be caused by the following situations: 

 The radio does not receive the system broadcasting message after it’s turned on.  

 The radio is out of the coverage of the XPT system. 

 All repeaters in the XPT site which the radio belongs to are power-off or can not connect to the IP 

network. 

 

Q: Why does the radio display “Call Deny!” when it initiates a call?  

A: This issue may be caused by the following situations: 

 The channel of the free repeater assigned by XPT system is not within the sharing channel list of the radio 

 The member order of the sharing channel list is not consistent with that of the operating channel of the 

repeater.  

 When calling back in a cross-site call, the radio cannot receive responses from the master site which starts 

the cross-site call.  

 When a radio is shaking hands with other radios in one slot, the repeater informs it to jump to the other slot 

repeatedly. 

 The repeater assigned to the radio by XPT system is disconnected from the network.  

 

Q: Can other repeaters in XPT single-site system work normally when one of the repeaters disconnects from the 

network? 

A: Yes. The entire network is similar to a peer-to-peer network. The Master repeater is used for registration and 

broadcasting address. If a Slave repeater disconnects, the Master repeater can detect and broadcast it to other 

Slave repeaters; if the Master repeater disconnects, all Slave repeaters still can work. However, new address 

cannot be added and the status of other repeaters cannot be acquired until the Master repeater restores to normal 

operation.  

 

Q: When a repeater is used for dispatching, why no GPS data or RRS data is displayed on the dispatch station 

even after the radio has been configured the related parameters to transmit the data? 

A: This issue may be caused by the following situations: 

 Wrong Control Center ID is configured. When a repeater is used for dispatching, it shall be within 

65280～65535. 

 Different RRS Port or GPS Port is (are) configured for the data repeater and the dispatch station, 
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 The frequency corresponding to the radio sequence number is different from that to the repeater index. In 

this case, the radio cannot communicate with the repeater. 

 No Quick GPS System is configured in the Data Channel of the XPT site. In this case, when the radio 

roams to this XPT site, it will be unable to transmit the GPS data via “Quick GPS” feature. 

 Members in Roam List of the radio are different from that of the master site. In this case, if Follow All 

Master Site Config is selected, when the radio roams to a new master site, the related parameters to the 

GPS data or RRS data will be changed This will also cause the failure of the data transmission. 

 (Only for the repeater below R8.1) All data repeaters in the site are offline or disconnected. 

 (Only for the repeater below R8.1) Wrong configuration in the data channel. The repeater can forward the 

data only through data channel. If only one data channel is configured and its Channel Type is set as 

Quick GPS, the radio will be unable to report RRS data and GPS data. 

 

Q: Why the repeater cannot perform the “IP Multi-site Connect” feature? 

A: This issue may be caused by the following situations: 

 The “IP Multi-site Connect” feature is NOT enabled. 

 The “Network Authentication Key” of the slave repeater is different from that of the master repeater. 

 The unstable network cause the failure, 

 

Q: Why the data transmission is abnormal when a repeater works as the dispatch station? 

A: This issue may be caused by the following situations: 

 The Application Programming Interface of the repeater is configured improperly. In this case, the repeater 

cannot communicate normally with the third party equipment. 

 Data List of the radio is set as None. For the repeater below R8.1, it can forward the data only through the 

data channel. Thus the parameter cannot be set as None. 

 

6.2 XPT Multi-Sites 
Q: How to calculate the required bandwidth?  

A: During networking, plan the bandwidth for the data services according to the requirement on bandwidth of 

voice services. In XPT system, the amount of sent data of each voice repeater is much greater that the received 

data. Therefore, it is recommended to calculate the bandwidth according to the amount of sent data. When two 
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time slots in digital channel are utilized simultaneously, such amount of data (including some additional data) is 

about 50 kbps. Assume that there are N XPT sites, each of which has M voice repeaters. During two slots 

operation and inter-site transmission, each voice repeater needs to send data to M * (N-1) voice repeaters at 

most. Thus, in case that only voice services are considered, the bandwidth requirement for each site is:  

M * (N-1) * 50 kbps 

If dispatching functions are required in addition of voice services, the bandwidth requirement for each site is:  

M * (N-1) * 50 kbps + M * 194 kbps 

If dispatching functions and SIP Phone feature are required in addition of voice services, the bandwidth 

requirement for each site is:  

M * (N-1) * 50 kbps + M * 194 kbps + M * 172 kbps 

If dispatching functions, SIP Phone feature and XNMS system are required in addition of voice services, the 

bandwidth requirement for each site is:  

M * (N-1) * 50 kbps + M * 194 kbps + M * 172 kbps + M * 11.72 kbps 

The above calculation results are the requirement for uplink bandwidth. It is recommended that the 

downlink bandwidth adopts the same requirement to ensure better communication quality. If the uplink 

bandwidth and downlink bandwidth are 50% of the total bandwidth respectively, the total bandwidth 

should be two times of the above calculation result.  

 

Q: Is XPT multi-site system secure?  

A: Yes. XPT multi-site system provides a certain degree of security, allowing encrypted data transmission in the 

system when the sites are connected to each other through IP network. For single-site system, every device that 

wants to access the system needs to comply with the relevant application layer protocol. Also, authentication 

code is required for registration with the master repeater. Moreover, the relevant protocol commands are 

encrypted during communication. A firewall is recommended when the device is connected through public 

network. 

 

Q: Why does the radio display “Not Available” when the PTT key is pressed and then released frequently? 

A: If the Call Hang Time is set to 0 for each XPT site, a call will be terminated once it has been set up. Due to 

the jitter buffer feature of the network layer, it takes the jitter buffer time (one second at least) to inform the 

called radio of the status that a call has been terminated. In this case, when the calling party presses the PTT 

key the next time, it is likely that the called radio does not receive the call termination signal. Thus, the XPT 
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system presumes that the calling radio is still in calling status and rejects the call initiated by it. Thus the prompt 

“Not Available” appears. 

To solve this problem, please set the Call Hang Time to an integer that is greater than the jitter buffer time. 

 

Q: When a cross-site group call is initiated, why the call is always delayed or even cannot be received?  

A: This issue may be caused by the following situations: 

 The Beacon Duration is too short. In this case, the called radio cannot switch to the corresponding site to 

receive the call in time. Please configure the Beacon Duration according to Table 4-4 Descriptions on 

Common Parameters of XPT Site. 

 The frequency spacing is too narrow, which causes the channels interfere each other. In this case, the radio 

decodes the wrong information and is unable to receive the call. It is recommended to deploy the channel 

frequencies according to Frequency Configuration Requirements. 

 Wrong channel frequencies are configured, thus the radio cannot switch to the specified channel to receive 

the call. 

 The radio ID is the same as Repeater ID, thus the call cannot be established. 

 Different XPT sites are deployed in the same network section. In this case, the XPT system cannot operate 

normally, thus the cross-site call fails to be established. 

 The XPT Multi-sites feature of the repeater is NOT enabled, thus the radios of different sites cannot 

communicate with each other. 
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Abbreviations 
Abbreviation Full Name 

AIS Application Interface Specification 

CPS Customer Programming Software 

CWID Continuous Wave identification 

DHCP Dynamic Host Configuration Protocol 

GPS Global Position System 

IP Internet Protocol 

IPPBX IP Private Branch Exchange 

NAT Network Address Translation 

OTAP Over the Air Programming 

PSTN Public Switched Telephone Network 

TCP Transmission Control Protocol 

UART Universal Asynchronous Receiver/Transmitter 

UDP User Datagram Protocol 

RRS Radio Register Service 

SIP Session Initiation Protocol 

XNMS Extended Network Management System 

XPT Extended Pseudo Trunk 
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